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Copyright and Legal Notice

Copyright © 1998-2010 Dialogic Corporation. All Rights Reserved. You may not reproduce this document in whole or in
part without permission in writing from Dialogic Corporation at the address provided below.

All contents of this document are furnished for informational use only and are subject to change without notice and do not
represent a commitment on the part of Dialogic Corporation or its subsidiaries ("Dialogic"). Reasonable effort is made to

ensure the accuracy of the information contained in the document. However, Dialogic does not warrant the accuracy of this
information and cannot accept responsibility for errors, inaccuracies or omissions that may be contained in this document.

INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH DIALOGIC® PRODUCTS. NO
LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE, TO ANY INTELLECTUAL PROPERTY RIGHTS
IS GRANTED BY THIS DOCUMENT. EXCEPT AS PROVIDED IN A SIGNED AGREEMENT BETWEEN YOU AND
DIALOGIC, DIALOGIC ASSUMES NO LIABILITY WHATSOEVER, AND DIALOGIC DISCLAIMS ANY EXPRESS OR
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WARRANTIES RELATING TO FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY, OR
INFRINGEMENT OF ANY INTELLECTUAL PROPERTY RIGHT OF A THIRD PARTY.

Dialogic products are not intended for use in medical, life saving, life sustaining, critical control or safety systems, or in
nuclear facility applications.

Due to differing national regulations and approval requirements, certain Dialogic products may be suitable for use only in
specific countries, and thus may not function properly in other countries. You are responsible for ensuring that your use of
such products occurs only in the countries where such use is suitable. For information on specific products, contact
Dialogic Corporation at the address indicated below or on the web at www.dialogic.com.

It is possible that the use or implementation of any one of the concepts, applications, or ideas described in this document,
in marketing collateral produced by or on web pages maintained by Dialogic may infringe one or more patents or other
intellectual property rights owned by third parties. Dialogic does not provide any intellectual property licenses with the
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Hardware Limited Warranty

Warranty for Hardware Products: Dialogic Corporation or its subsidiary that originally sold the hardware product
("Dialogic") warrants to the original purchaser of this hardware product, that at the time of delivery the hardware product
supplied hereunder will be free from defects in material and workmanship. This warranty is for the standard period set
out on Dialogic's website at http://www.dialogic.com/warranties and is void if the defect has resulted from accident,
misuse, abuse or misapplication. Any hardware product which becomes defective during the warranty period and is
returned by the original purchaser to Dialogic's Authorized Service Center with a Return Material Authorization (RMA)
number (which must be obtained from Dialogic before any return) within thirty (30) days after discovery of the defect with
a written description of the defect will be repaired or replaced at Dialogic's option. Freight charges will be paid by Dialogic
only for shipment back to you.

Additional Exclusions: Dialogic will have no obligation to make repairs or replacements necessitated by your fault or
negligence, improper or unauthorized use of the product, repairs or modifications made without Dialogic's prior written

approval or by causes beyond the control of Dialogic, including, but not limited to, power or air conditioning failure, acts
of God, improper interface with other units, or malfunction of any equipment or software used with the Dialogic product(s).
If Dialogic is requested and agrees to make repairs or replacements necessitated by any such causes, you will pay for such
service or replacement at Dialogic's then prevailing rates.

No Other Warranties: DIALOGIC DISCLAIMS AND YOU WAIVE ALL OTHER WARRANTIES, EITHER EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-
INFRINGEMENT AND FITNESS FOR A PARTICULAR PURPOSE AND ANY WARRANTY AGAINST LATENT
DEFECTS, WITH RESPECT TO ANY DIALOGIC PRODUCT.

No Liability for Damages: IN NO EVENT SHALL DIALOGIC OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES
WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, INTERRUPTION OF
ACTIVITIES, LOSS OF INFORMATION OR OTHER PECUNIARY LOSS AND DIRECT OR INDIRECT,
CONSEQUENTIAL, INCIDENTAL, ECONOMIC OR PUNITIVE DAMAGES) ARISING OUT OF THE USE OF OR
INABILITY TO USE ANY DIALOGIC PRODUCT.

Limitation of Liability: DIALOGIC'S MAXIMUM CUMULATIVE LIABILITY SHALL BE LIMITED TO THE
AMOUNTS ACTUALLY PAID BY YOU TO DIALOGIC FOR THE SPECIFIC PRODUCT BEING THE OBJECT OF THE
CLAIM. YOU RELEASE DIALOGIC FROM ALL AMOUNTS IN EXCESS OF THE LIMITATION. YOU
ACKNOWLEDGE THAT THIS CONDITION IS ESSENTIAL AND THAT DIALOGIC WOULD NOT SUPPLY TO YOU
IF IT WERE NOT INCLUDED.
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About this Publication

Introduction

This Dialogic® Brooktrout® Fax Products Windows® End User
Guide is for users running either of the following in a Windows®
environment:

m  Dialogic® Brooktrout® SR140 Fax Software

m  Dialogic Brooktrout® TR1034 Series and Dialogic Brooktrout®
TruFax® boards.

Refer to the Dialogic® Brooktrout® Fax Products Linux End User
Guide if you operate in a Linux environment.

This document contains the following:

m  Chapter 1 explains how you get started installing and
configuring Dialogic® Brooktrout® software and hardware in a
Windows® environment.

m  Chapter 2 explains how to install your Dialogic® Brooktrout®
TR1034 Series and Dialogic® Brooktrout® Trufax® boards.

m  Chapter 3 describes how to activate Dialogic® Brooktrout®
SR140 Fax Software using the Dialogic® Brooktrout® License
Manager.

m  Chapter 4 describes how to configure the Dialogic® Brooktrout®
Fax Software, Dialogic Brooktrout® TR1034 Series boards, and
Dialogic Brooktrout® TruFax® boards.

m  Chapter 5 explains testing the Dialogic® Brooktrout® SR140
Fax Software and Dialogic® Brooktrout® Trufax® boards. This
chapter does not apply to users of the Dialogic Brooktrout®
TR1034 Series and Dialogic Brooktrout® TruFax® boards.
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Chapter 6 provides specifications for Dialogic® Brooktrout®
TR1034 Series and Dialogic® Brooktrout® Trufax® boards.

Manual Conventions

< 4

This manual uses the following conventions:

Italics denote the names of variables in the prototype of a
function, and file names, directory names, and program names
within the general text.

The Courier font in bold indicates a command sequence entered
by the user at the system prompt, for example:

cd /Brooktrout/boston/bfv._api

The Courier font not bolded indicates system output, for
example:

C:>Files installed.

The Courier font also denotes programming code, such as C and
C++. Programming code appears in program examples.

Bold indicates the data type of the prototype of a function,
Dialogic® Brooktrout® Bfv API functions, dialog boxes, dialog
box controls, windows, and menu items.

Square brackets [ ] indicate that the information to be typed is
optional.

Angle brackets < > indicate that you must supply a value with the
parameter.

The Caution icon is used to indicate an action that could cause harm to
the software or hardware.

The Warning icon is used to indicate an action that could cause harm to
the user.
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Related Documents

Related Documents

For product information, white papers, FAQs, and more, access the
Dialogic web site at www.dialogic.com.
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Related Documents

Telephony Requirements

Physical Media Call Control
Ethernet 10/100 | T.38 vO H.323
RTP V2 G.711 SIP

Terminology

Updated Terminology

The current version of this document includes terminology that
differs from previous versions. Please note the changes below:

Former Terminology

Replaced with...

Host-based fax

Virtual modules

Virtual boards

Software modules

VolP modules

SR140 virtual modules

Dialogic® Brooktrout® SR140 Fax Software
or

Brooktrout SR140 Fax Software

or

SR140 Software

or

SR140

TR1000 Series SDK

Dialogic® Brooktrout® SDK

TR1000 Series Product

TR1000 Series Module

TR1000 Series Board

Dialogic® Brooktrout® Fax Board
or

Brooktrout fax board

or

board

Brooktrout System Software

Dialogic® Brooktrout® Runtime Software

December 2010
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Related Documents

Dialogic® Brooktrout® TR1034 Fax Board Terminology

The Dialogic® Brooktrout® TR1034 Fax Board is also referred to
herein by one or more of the following terms, or like terms including
“TR1034":

Brooktrout TR1034 Fax Board

Brooktrout TR1034 Board

TR1034 Fax Board

TR1034 Board

TR1034

December 2010
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Getting Technical Support

Getting Technical Support

Dialogic provides technical support and services for customers who
have purchased hardware or software products from Dialogic. If you
purchased products from a reseller, please contact that reseller for
technical support.

To obtain technical support, please use one of the following methods:

Web: www.dialogic.com/support/default.asp

Technical http://www.dialogic.com/support/helpweb/default.aspx

Help Web

Phone: North America: +1 781-433-9600
Belgium: +32 2-658-5170
Japan: +81 3-3234-2176
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1 - Getting Started

This chapter provides an introduction and quick start installation
instructions for installing the Dialogic® Brooktrout® software and
hardware in a Windows® environment.

Refer to the Dialogic® Brooktrout® SR140 Fax Software Linux User
Guide if you operate in a Linux environment.
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Fax Board and Virtual Modules (SR140)

Fax Board and Virtual Modules (SR140)

Dialogic’s intelligent fax board platform, the Dialogic® Brooktrout®
TR1034 Fax Board, provides Dialogic ISV (Integrated Software
Vendor) partner’s fax application with the capability to communicate
from their application to the telephone or IP network.

For software-only systems using IP only, Dialogic implemented the
SR140 as a virtual module. Although it is software, the SR140
appears to the fax application just like a board. That helps simplify
your fax application publisher to provide a single product that works
for hardware and software

December 2010
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SR140 Product Family

SR140 Product Family

There are two major SR140 products, the original full SR140 and the
SR140-L. Each product differs in the available functionality, with
the full SR140 having the highest functionality. The tables below
summarize the feature set available for the different SR140 products
over the course of their release history.

Note: Full SR140 and SR140-L licenses cannot co-exist in the same
system.

Table 1. Full SR140 Release History

Release

Date Example Model Name Feature Set

R1

March 2008 | SR140-4F m T.38V17

Advanced Fax (Very High Res,
MMR, JBIG/Color pass-
through)

R2

February SR140-4F-V34 m T.38V34
2009 T.38 V17

Advanced Fax (Very High Res,
MMR, JBIG/Color pass-
through

R3

G.711 RTP
IVR

T.38 V34
T.38 V17

Advanced Fax (Very High Res,
MMR, JBIG/Color pass-
through

April 2010 SR140-4-R3

December 2010
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SR140 Product Family

Table 2. SR140-L Release History

Release

Date

Example Model Name

Feature Set

R1

April 2010

SR140-L-4-R1

m Maximum eight channels per
system

T.38 V17

Advanced Fax (Very High Res,
MMR, JBIG/Color pass-
through)

Feature Pack Licenses

Feature pack licenses are available to allow you to add features
matching a later release. The feature pack license is added to your
existing license to bring you up to the latest set of available features.

For example, if you currently own an original SR140 R1 (SR140-4F),
you can obtain an upgrade pack license (SR140-FeaturePack-4-R3)
that will add in the new features, without first requiring an R2
feature pack license.

SR140 Product

Full SR140

SR140-L

R1 Release

R2 Release R3 Release

v

———————— - »

SR140 Feature Pack

A

-------- -

SR140-L Feature Pack

December 2010
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SR140 Product Family

Upgrade Licenses

Upgrade licenses allow you to add the feature set of the full SR140 to
the SR140-L.

For example an SR140-L-2-R1 together with a SR140-L-UPGRADE-
SR140-2-R3 will have the same features as an SR140-2-R3.

SR140 Product

Full SR140 .

S

_.-="" SR140-L ;
T Upgradeto
-7 SR140 !
SR140-L >

Demonstration Licenses

Demonstration licenses are available for both the SR140 and
SR140-L. Demonstration licenses will cause each transmitted or
received page to be overlaid with the word '‘Demonstration’. Only one
demonstration license can be installed in a system at any time and
cannot be used together with non-demonstration licenses.

Demonstration licenses expire after some time period, typically 30
days from when the license was first activated. The License Manager
displays when a demonstration license is due to expire. If a
demonstration license expires, it will cause the SR140 to stop
functioning. You will need to use the License Manager to delete any
demonstration licenses that have expired, or before you can use a
non-demonstration license.
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Software Licenses

Software Licenses

The SR140 Virtual Module is delivered together with your fax
application. The SR140 license is the right to use the software
products in an entitlement purchased from Dialogic. The license is
represented by the contents of a License File that is used by the
software to restrict use to that entitlement. When you install the
software, you acknowledge the License Agreement that governs
SR140 licensing. Your License is delivered in paper form and shows
you what your entitlement is, and provides a License Key to allow
you to apply your entitlement to a computer system when you install
the SR140 Fax Software.

Make sure to keep your License Key certificate in a safe place, where
you can find it easily.

December 2010
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Product Activation

Product Activation

Configuration

As well as helping you stay within your entitlement, your SR140 Fax
Software product uses copy protection technology. Following
installation of the software, Product Activation is a process for tying
a license to a particular system, limiting use of that licensed
software to one computer system. Product Activation is simple and
may be completed via the Internet, email or by fax and involves
supplying your License Key shown on the License Key certificate and
a unique identifier of the computer system that can be used to lock a
license to a computer (known as node-locking).

All modules - virtual modules or real boards - need to know how to
handle call control over the IP network. Once you have installed the
software and activated your product, you need to enter settings that
control how connections are made between the IP network and the
virtual module. This process is called configuration.

Getting it Working

Follow the steps below to get your Brooktrout fax hardware and/or
software working.
m  Hardware Installation
m  See Installing TR1034 and Trufax® Hardware on page 21
m Software Installation
See Verifying Software Installation on page 5.
®  Product Activation

See Using the License Manager to Activate Brooktrout Products on
page 9.

®m  SR140 Configuration

See Configuring Dialogic® Brooktrout® SR140 Software and
Dialogic® Brooktrout® TR1034 /Trufax Boards on page 63.

m |P Configuration
See IP Call Control Modules on page 111.
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Product Activation

B Test

See Testing the Dialogic® Brooktrout® SR140 Fax Software on
page 123.
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2 - Installing TR1034 and Trufax®
Hardware

This chapter applies to users of the Dialogic® Brooktrout® TR1034
Series and Dialogic® Brooktrout® Trufax® boards. This chapter does
not apply to users of the Dialogic® Brooktrout® SR140 Fax Software.

For detailed hardware installation instructions, see the hardware
installation card that came with your Brooktrout board.
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Installation Overview

Installation Overview

This section describes how to install your fax board on a Windows
Server 2003 system.

If you already have the Brooktrout System Software installed and
working on your system, do the following:

Install your fax board. Refer to Installing Your Board on page 23.

Reboot your computer and configure the telephony for your
Brooktrout board.

Enter your dialing information.

Verify the installation. Refer to Verifying Brooktrout Board
Installation on page 24

Register with Dialogic.

If this is a new installation, do the following:

Check your system to verify the minimum system requirements.
Install your fax board. Refer to Installing Your Board on page 23.

Reboot your computer and configure the telephony for your
Brooktrout board.

Enter your dialing information.
Refer to Verifying Brooktrout Board Installation on page 24
Register with Dialogic.

Decmeber 2010
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Installing Your Board

Installing Your Board

Before installing your board, make sure you have assigned the board
a unique module number (see Determining the Board Module

Number).

» Follow these instructions to install your Brooktrout board
into your computer:

1. Power off your PC and any peripheral equipment connected to it.

2. Unplug your PC power cord.

3. Remove the outside cover of your computer.

4. Open your computer and locate a free PCI slot in the computer
chassis.
Remove the slot cover.
Carefully align the Brooktrout board with the PCI slot and firmly
seat the board into the slot.

7. Tighten the mounting bracket screw to secure the board to the

chassis.

Warning: When installing the board, be sure that the mounting bracket is

grounded three prong plug. Improper chassis or bracket grounding can

? securely fastened to the chassis and the chassis is plugged into a

result in harmful or fatal electrical shock as well as component damage.

10.

11.

Replace the outside cover of your computer.

Use the cable supplied with your board and connect one end of the
cable into the RJ-45 telephone connector on the board’s mounting
bracket.

Plug the other end of the cable into the wall connector for your
telephone service.

Reconnect your PC power cord, and power on your computer.

Decmeber 2010
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Installing Your Board

Verifying Brooktrout Board Installation

» Verify that the Brooktrout board is successfully installed
in your system:

1. Click either:

¢ Control Panel, Administrative Tools, Computer Management
¢ Control Panel, System, Hardware, Device Manager

The following screens appear, respectively.

-ioix
g File  Action Yiew ‘Window Help |_|ﬁ'|1|
o BAEFS 2 al=na

WK 3-HOSTSW-04
_J Computer
Computer Telepho

E Computer Management {Local)
Elm System Tools
+ @ Event Yiewer

Shared Folders S

% Local Users and Groups H|-age Disk drives
Performance Logs and Alert: - :_g Display adapters
Device Manager H iy DYDYCD-ROM drives
EI@ Skorage 1= Floppy disk controllers
g,‘ Removable Storage ]& Floppy disk drives

& Disk Defragmenter H-=y IDE ATAJATAPT controllers
,‘i. Disk Management H-z» Keyboards
[]--& Services and Applications - ") Mice and other painting devices
H-- 5 Manitars
+|- B8 Metwork adapters
]--@ Cther devices
H- o Ports (COM &LPT)
- #¥8 Processors
]--@% SCSI and RAID controllers
7@, sound, video and game controllers

H- i System devices
-8 Universal Serial Bus controllers
| | o

i 0 o O O O o O O O ot O e O e s O o O e O e

2. After installing your Brooktrout fax board, allow Windows Plug
and Play to locate and accept the device driver for the Brooktrout
board.

You must wait several moments while Windows Plug and Play
v performs board verification and driver installation. Do not use your
mouse or press any keys on your keyboard during this time.
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Installing Your Board

-ioix

File  Action Yiew Help
F2|BEFS 28 =na

B - WK 3-HOSTSW-04
j Computer
[-E8 ComputerTelephor
: =¥ Erooktrout TR
[#-g# Disk drives
- § Display adapters
[k DVDICD-ROM drives
(-4 Floppy disk controllers
[]---_g Floppy disk drives
-4 IDE ATAJATAPI controllers
[z Keyboards
") Mice and other pointing devices
-8 Moritors
£
£
£
£
£
£
£
£

|- EE) Metwork adapters

]--‘a Cther devices

H- o Ports (COM &LPT)

-4 Processors

]--@% SCSI and RAID controllers

1), Sound, video and game controllers

H- i System devices
-8 Universal Serial Bus controllers

Viewing Brooktrout Board Properties

» To view the board’s properties:

1. Double-click the board name in one of the screens, as shown in the
above window. The Brooktrout TRxStream Board Properties
dialog box appears.

2. Click the Device Details tab.

Decmeber 2010
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Installing Your Board

Brooktrout TRxStream Board Properties

General Device Details | Criver I Detailsl Hesourcesl

Brooktrout TR=Stream Board - Module 052

Feature Infarmation

2|

Version 1

VendorId : BS

Seriall : 61007066

MACAddrl : 00-00-00-00-00-00
MACAddr2 : 00-00-00-00-00-00
PartHum : 80101905

PartRew : 0o

FtrLockK : True

ShipHum : 90100405

ShipRew ]

YoiceCh : 2

Fa=xCh : 2

Click on Configure to launch the Configuration T ool.

0K

Cancel |

3. Click the Configure option to use the Brooktrout Configuration
Tool to configure telephony.
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3 - Activating Dialogic® Brooktroute®
SR140 Fax Software

This chapter describes how to activate a license for the Dialogic®
Brooktrout® SR140 Fax Software.

The SR140 Fax Software functionality is protected against piracy
and abuse by licensing technology that uses product activation. A
License Key is sold to the user who exchanges the key for a license
file during or after installing the software. The license file is tied to
the system during activation by imprinting a unique system
signature (a Node ID) on the license file, and is based on the
machine's MAC address.

The License Key can either be a unique, paid-for license key that
provides a perpetual license or a demonstration license key that
results in software that provides limited support for a limited time.
Both types of product - licensed as demonstration or paid-for -
require activation. You have several ways to activate the product.

You can use the Dialogic® Brooktrout® License Manager application
to verify information about current licenses and to add new licenses
for your Dialogic® Brooktrout® products.
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The application also verifies the following:

The signature of the license is not broken.
The license is not expired.

The Node ID of the license matches the Node ID of the computer
(sometimes referred to as the “Node Lock” of the computer).

The system clock is not set back.

Please contact Dialogic Technical Services and Support if you are
unable to use the license. See Getting Technical Support on page 12.

This document has the following sections:

Preparing for Activation on page 29.

Using the License Manager on page 30.

Activating a License Automatically on page 36.
Activating a License Using the Web on page 41.
Activating a License Using Email or Fax on page 47.
Installing Licenses on page 49.

Logging Information on page 51.

Managing License Files on page 52.

Removing Licenses on page 53

Re-installing a License on page 54
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Preparing for Activation

Preparing for Activation

To use the License Manager to activate your Brooktrout product,
perform the activation process from the system where the Dialogic®
Brooktrout® SR140 Fax Software is installed. Once the license is
activated, install the license file on that system (unless you activate
automatically which does not require installation).

Because the SR140 Fax Software is an IP-based technology, Dialogic
uses the IP network and the Internet to perform Product Activation.
Ideally, the system you are installing on should be connected to an
IP Network and to the Internet.

However you activate, Dialogic strongly recommends that you
archive the License Certificate and the License File once the product
has been activated.

Automatic activation must be performed using the License Manager
on the system which is to be licensed.

Note: Because the license verifies if the system clock has been set
back, you should ensure that the system date is set correctly.
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Using the License Manager

The License Manager application is usually installed with your fax
application.

B To start the License Manager, use one of the following methods:
¢ Start the License Manager from the Configuration Tool

¢ Select Start » Program Files — Brooktrout —»
Brooktrout License Manager

* Ifyou accepted the standard location to install your software,
double-click the brktlicmgr.exe file at the following location:

C:\Brooktrout\Boston\bin

Otherwise, go to the location where you chose to install the
software and double-click the brktlicmgr.exe file.

The License Manager window appears.

H & Brooktrout License Manager
. License  Utilities  Help

1 =
- Activate...

e

X

Remove.

Install.

Description [ Product [ version | status [ 1ssued [ Expires [ Mode 1o | serial #
| [sR140-Internal Developer  SR140 1.0 valid 02-Apr-2010  permanen £ FA4ECZFD36... BRKTL08: 15268
SR140-Internal Developsr  SR140 1.0 valid 26-Mar-2010  permanent FA4ECZFD35... BRKT108: 15130

This window shows information for any installed licenses. The
application tries to determine license integrity and authenticity.

Typical problems when validating licenses:
1. The license can have a broken signature.
2. The license can expire.

3. The license can have the wrong Node ID.
4. System clock can be tampered.

If the license has more than one problem, only the first detected
problem is indicated. For example, if the license has expired and
has a broken signature, only the broken signature is indicated on
the main screen.
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Displaying and Copying Node IDs

There may be more than one MAC address on the system. If so, you
can choose the MAC address in which to lock. The License Manager
allows you to view the Node ID representation of the first 20
Ethernet Adapter MAC addresses available on the system.

You need to use this function in order to node lock to a MAC address
in the system other than the default MAC address used for node
locking.

For information on node locking refer to Overriding the Default MAC
Address Used for Node Locking on page 40.

» Follow the steps below:

1. From the Utilities menu, select Display all node IDs. A screen like
the following appears.:

Node ID List

Listed below are the possible VID Mode 1Dz and their descriptions.

Node ID | Description

E16950343FEEDSFZE1F3660E74F32003  [Activation Mode Lock] SMC EtherPower IT 10/100 Ethernel
TEC4698157DE04AZFSFOCEESOATCESEZ  Juniper Metwork Connect Yirtual Adapter
34CES9302A424BCEB37DETIRC265C83A  Broadcom Metktreme Gigabit Ethernet For hp - Packet Sche

0K

2. Double-click to select the Node ID. Right click and select Copy to
copy the Node ID.
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Displaying and Copying Node ID
» Follow the steps below to display and copy a Node ID

(referred to as Node Lock in the screen below).

1. From the Utilities menu, select Display Node Lock. A screen like
the following appears:

Activation Node Lock

Mode Lock Type: |VID

Hode Lack: |E16950345F6E DAF 2B 1 FSEE0E 74F 32003

2. Double-click to select the Node ID. Right click and select Copy to
copy the Node ID.
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Starting the License Activation Wizard

» Start up the License Activation Wizard by selecting
Activate License from the License menu.

1. Select License -> Activate license...
If a Demonstration License Key file (.dIKk) file is located, then the
License Activation Wizard Welcome dialog below appears. If no
Demonstration License Key file (.dlIk) is located, the Welcome
Dialog (no .dlk file) on page 34 appears:

License Activation Wizard l ﬂ
Welcomel

Welcome to the License Activation Wwizard.

The “Wizard helps you uze your License Key to activate the
licenze for the ingtallation on thiz computer.

The Brooktrout License Manager haz detected the presence
- . of an SF!1_4D demo_ Iicense_ key proyided with wour application.
Dllale llc Do you wish to activate thiz demo license key, or do
g " you wizh to enter an externally provided license key?
Fleaze nate alzo that only one Demo license may be used at a time.

{* Use license key provided with my application
(" Enter externally provided license key

Select Mext to continue.

Help | < Back | Mext » | Cancel |

The .dlk file (Demonstration License Key file) contains a license
key for the SR140 demonstration mode. The user's application
can provide such a file. It will then be located in the same
directory as the License Manager executable. The .dlk file gets
read only when the License Manager is initially launched. Do not
edit this file while the License Manager is running.

2. Select Use license key provided with my application to
activate the demonstration license. If you would like to enter a
purchased license key then select Enter externally provided
license key.

December 2010 33



Starting the License Activation Wizard

Welcome Dialog (no .dlk file)
: x|

Welcome!

Welcome to the License Activation VWizard.

The Wizard helps you use your License Key to activate the

license for the installation on this computer.
Dialzgic

Select Mext to continue.

Help | < Back | et = | Cancel

3. Click Next. The Activation Method dialog box appears:

License Activation

Activation Method
Hows wiould you like to activate your license?
{+ Automatically [this computer is connected ta the Internet]
(~ Using the interactive web methad
(" Create a request for email or fax
- . Tipz: If thiz computer is connected to the Intemet, this iz an
D'Ialgg'lc automatic process. Othenwize you can activate your icense
' uzing another computer by accessing an activation web site
or by zending the activation information using email or fax.
Please note: If an SR140 Demo license exists on this machine,
it should be removed prior to installing a permanent SE140 license.
“r'ou may remove any SA140 licenze from the main screen of the
Brooktrout License Manager.
Fleaze naote alzo that only one Demo license may be used at a time.

Select Mext to continue.

Help < Back Mext » Cancel

4. Select an Activation Method.

+ Automatically (this computer is connected to the Internet)

Activates licenses automatically to the machine performing
the activation. This is the easiest method if your computer is
connected to the Internet. If successful, this step completes
the product activation process immediately. Your new license
files are displayed in the License Manager main window.
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See Activating a License Automatically on page 36.
Using the interactive web method

Activates licenses using the Dialogic License Activation
website. After successfully processing activation information,
you can choose to download the file immediately or have the
license emailed to you. Within a couple of minutes Dialogic
sends an email containing a license file, if you select to have
the license emailed to you. To complete the activation process,
use the License Manager interface to install the license file(s)
on the machine specified.

See Activating a License Using the Web on page 41.
Create a request for email or fax

See Activating a License Using Email or Fax on page 47. After
successfully processing activation information, Dialogic
sends an email containing a license file. To complete the
activation process, use the License Manager interface to
install the license file(s) on the machine specified in the
email/fax activation request. Dialogic sends a license in about
one working day.
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Activating a License Automatically

» To activate a Brooktrout license using the automatic
activation method, follow the steps below:

1. Select the automatic activation option above.

If you chose the option Use license key provided with my
application on the Welcome dialog then skip to step 5 below.

If you chose the option Enter externally provided license key
on the Welcome dialog or there was no .dlk file located when the
License Manager was launched, then the License Keys dialog

appears:
X

License Keys

Please enter all purchased License Keys

BRKT xoc20000000¢

- -
Dialegic
Add I Edit Delete
Select Next to continue.
Help | < Back | Mext > | Cancel |

2. Select the Add button to enter all purchased License Keys one at
a time.
You can enter more than one License Key. You must enter at least
one License Key to proceed, otherwise an Error dialog box
appears.

This License Key can be found on your Licence certificate. The
License Key is avariable length ASCI|I string. An example of such
a key is: BRKT111-1234567

Note: Click the Edit button if you need to correct the License Key
information. Click the Delete button if you need to delete
license key information.
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3. The Please enter License Key dialog box appears:

Please enter License Key x|

Flease enter License Key

(B4 Cancel

4. Enter the License Key and Click OK.
5. The Product Registration window appears:

License Activation Wizard ﬂ

Product Registration

Thiz spstem's activation information has been gathered to
werify that the License Key iz legitimate and has not been
activated on more spstems than allowed by the End User
Licenze Agreement.

Fleaze register your product to enable us to better support you.

Fratecting your information is wery important to Dialogic Corporation.
To view our privacy policy, see

Dialegic

hittp: £ A, dialogic. comdabout/privacy_palicy. htm

Select Mext to continue.

Help < Back Mext » Cancel

For your convenience, Product Registration follows activation in the
same session using the License Activation Wizard.

6. Follow the screen prompts if the Product Registration window
appears.

All but one of the registration fields are required (indicated by an
asterisk [*]). When required information is not entered, an Error
dialog box is displayed. Be sure to enter the information for the

person responsible for the day-to-day running of the installation.
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7. Verify that your computer is connected to the Internet.

8. Click Next to begin processing your license request.

The License Manager sends the license request to the Dialogic
License Activation Center, where your license request is
processed.

The request process can take a few minutes.

9. The Request Status window appears when the automatic
activation process is complete. The License Manager provides a
Tip when license activation fails. The Tip usually provides a
possible solution or where to get more information that leads to a
solution:

*

License Obtained

The requested license is automatically installed in your
system. The product activation process is complete.

Request Failed. Invalid license key.
The following is the tip associated with this failure:

Tip: The license key you are trying to activate is not valid.
Please confirm the license key was entered accurately into
the License Activation Wizard.

When a License Key is invalid because of a data-entry error,
re-enter the correct license key by running the License
Activation Wizard again. If the license key has been entered
correctly but the request status is invalid, contact Dialogic
Technical Services and Support. See Getting Technical
Support on page 12.

Request Failed. License already activated.
The following is the tip associated with this failure:

Tip: The license key you are trying to activate has already
been activated. You cannot activate the same License Key on
different systems. Please refer to your user documentation for
details about moving licenses from one system to another or
restoring lost licenses.

When you attempt to activate a license key for the second
time from the same or another computer, it is considered re-
hosting. Please contact Dialogic Technical Services and
Support for solutions to this problem. See Getting Technical
Support on page 12.
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Also see Managing License Files on page 52 for more
information.

*+ Request Failed. Cannot communicate with the License
Activation Center.

The following is the tip associated with this failure:

Tip: The License Activation Center cannot be reached. Please
check your Internet connection, network and firewall
settings. Please try again. You can also restart the License
Activation Wizard. Select either the option to use the
interactive web method or the option to request a license via
email or fax.

The License Activation Center cannot be reached because the
License Activation Center computer is temporarily
unavailable or you are experiencing temporary Internet
problems.

Attempt to correct the problem and retry the request. When
using the access numbers, if failures persist, contact Dialogic
Technical Services and Support. See Getting Technical
Support on page 12.

* Request Failed. Internal error code["err #"].
The following is the tip associated with this failure:

Tip: Please try again. You can also restart the License
Activation Wizard; select either the option to use the
interactive web method or the option to request a license via
email or fax.

If failures persist, contact Dialogic Technical Services and
Support. See Getting Technical Support on page 12.
10. Click Next.

The final License Activation Wizard window appears indicating
which license keys have been activated and which license keys
have failed activation.

11. Click Finish to complete your activation process.

Because you activated automatically, you do not need to install
licenses. Your activation process is finished.
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Overriding the Default MAC Address Used for Node Locking

Note: The follow procedure applies only to automated license

activation.

In some cases, when you have multiple MAC addresses in your
system, you may want to use a different MAC address other than the
default MAC address used for node locking.

Create a file named brktlicmgr.cfg and place it in the same directory
as the License Manager (for example Brooktrout\boston\bin).

This file should be a text file with a single line
‘NodelD=<enter node id here>’, with no spaces.

>

P wDdPE

To obtain the node ID for the MAC address you intend to
use follow the steps below.

Launch the License Manager.

From the Utilities menu, Select Display All Node Ids option.
Select the adapter.

Copy and paste into the brktlicmgr.cfg configuration file.

For details see Displaying and Copying Node IDs on page 31.
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Activating a License Using the Web

You can also activate your SR140 Fax Software license on the web
using a computer that has web access. This can be a different
computer than the server on which you are installing the SR140
virtual module.

It is critical that you enter the Node Lock information for the intended
machine (Node ID) on the website without errors. The software
generates an unusable license when you enter incorrect Node Lock
information. The second attempt to obtain the license using the corrected
Node Lock information is considered re-hosting. In this case see
Re-Hosting License Files on page 57

» To activate a license using the interactive web method, do
the following:

1. Start up the license manager.

Select Using the interactive web method as your method of
activation.

The following License Activation Wizard window appears:

License Activation Wizard |
Web Instructions

To request a license, please visit our website:

http:/www diglogic.com/activation

and follow the instructions provided on the website.

Dialogic will email the license to you immediatefy.

When prompted, supply the following information:

Mode Lock Type: VID
Mode Lock: SCEFA170F021850BC6DBD227EFFE486E

Dialegic

| Save the instructions into a file I

Select Next to continue.

Help < Back | Mext > Cancel |
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3. Click Save the instructions into a file button.

The instructions shown in the License Activation Wizard window
are saved to a file that you can print or refer to at a later date. The
instructions provide the Node Lock Type and the Node Lock that
you enter when activating from the web.

You can also display the Node ID information by selecting Display
Node Lock under the Utilities menu in the License Manager
window.

On a computer that has Internet Access, enter the web address
www.dialogic.com/activation, which directs you to a secure
server. The following screen appears.

Please Login

License Key*: |

* Please enter the License Key exactly as it appears on your certificate.

Enter your original License Key (this can be found on your
License certificate) and click Submit. The following screen
appears.

December 2010

42


http://www.dialogic.com/activation

Activating a License Using the Web

Dialzgic

Generate, Re-Host or View Licenses

l Generate Licenses %“ Re-host Licenses H Yiew Licenses

* Generate License - to create a new license from your License Key; Re-Host Lice
to view or download a license you have already activated.

Click Generate Licenses. The following screen appears.

Select Items to Activate

Select Product:

Filter Products

950-101-v34-30 1.0 SR140-30F

950-101-434-30 1.0 SR140-30F

Cirder Item # Lovail/ Total
BRKT3S 1 95/100
License Type: Locked Uncounted
Mode ID Type: v
Mode ID:

[ Generate License ]
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7. Select the Product you are activating. Select the Node ID Type
and enter the Node ID. If you are using License Manager version
2.0 or greater, select Node ID type VID. If you are using an earlier
version than 2.0, select Node ID type COMPOSITE.

Select Items to Activate

Select Product: 5950-101-34-30 1.0 SR140-30F
950-101-v34-30 1.0 SR140-30F
Cirder Item # Lovail/ Total
BRKT3S 1 95/100
License Type: Locked Uncounted
Mode ID Type: v
Mode ID:

[ Generate License ]

8. Click Generate License.

Confirm your Selection

950-101-v34-30 1.0 SR140-30F
Cirder Item # Lovail/ Total
BRKT3S 1 95/100

License Type: Locked Uncounted
Mode 1D Type: WD

Mode ID: S10CF1B311E99E23F3691D66C10D2ELY 4
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9. Verify that the information on this screen is correct and click
Confirm. The following screen appears.

Dialegic

Deliver License

FEATURE SR140 BRKTD 1.0 permanent uncounted b
VENDOR_3TRING=VoiceCh=0:FaxCh=30:Links=0:V3i4Enab=30: dviph=0:idvFax=30:Ti§Enab=30 4
HOSTID=VID=910CF1E311E99E23F3691D66CIDZEL74 ISSUED=10-Jan-2008 Y4
SN="BRKT35: 2696" TS_OK SIGN="09FC 80C3 A2A6 DD76 2805 S53F3 3
AEDF CC36 5495 09AL 4CFE 69B0 S54F3 D306 7D54 1447 496D OCFC 4
4Cp4 CED& 530D SACC €100 1DD7 13C6 AEOD ZEDF FA33 AESY EDSE"

Save to File

Send £ [y iginiti@dialogic. com

10. Click Save to File to save the license file to your computer or click
Email to have the License file emailed to you. The following screen
appears.

Dialzgic

Deliver License

License has been sent to: bfulginiti@dialogic.com
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11. Follow the instructions Installing Licenses on page 49 to install
the license file.
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Activating a License Using Email or Fax

When your system cannot support the previous options (for example,
you have no Internet connections) you can activate your license by
sending the information to Dialogic using email or fax.

Note: If you activate your license by email or fax, Dialogic will send
you the license file in about one business day.

» To activate a license by Email or Fax, do the following:

1. Start up the license manager.
Select Create a request for email or fax as your method of

activation.
3. Click Next.
The following License Activation Wizard License Key dialog box
appears:
x|
License Keys
Please enter all purchased License Keys
BRKT soc30000000¢
Dialegic
Add I Edit Delete

Select Next to continue.

Help < Back Mext > Cancel
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¢ Select the Add button to enter all purchased License Keys
one at a time.
You can enter more than one License Key. You must enter at
least one License Key to proceed, otherwise an Error dialog
box appears.

The Please enter License Key dialog box appears (this License
Key can be found on your License certificate, for example
BRKT111-1234567):

Please enter License Key x|

Please enter License Key

[0];9 I Cancel |

Click Next and fill in the registration information as requested.
5. Click Next.
The Email/Fax Request dialog box appears:

6. Click the Save the request into a file button to save all information
entered into the Product Registration dialog boxes to a text file.

7. Email the saved file to activation@dialogic.com as an attachment,
or fax this information to +1 781-433-2350 at the Dialogic License
Activation Center for processing.

When you receive the license file from Dialogic, go to Installing
Licenses on page 49 to install it in the correct location.
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Installing Licenses

When you receive a license file from the Dialogic License Activation
Center (via email or saved from the site) use the License Manager
application to install the attached license.

If you receive the license file via email, the licensing information is
sent to you in the body of the e-mail. You must create a file with a
.LIC extension and copy the licensing information from the e-mail
into that file. If you save the license file from the site, you save the
file to a temporary site as indicated in step 1 below.

Note: If you use the automatic activation method, you do not need to
install licenses. Your activation process is finished.

» Follow the steps below to install a license:

1. Save the license file to a temporary location (for example,
\brooktrout\boston\bin) on your hard drive.

2. Start the License Manager by selecting the following:

¢ Start — Program Files — Brooktrout — Brooktrout License
Manager

3. The License Manager window appears.

-

Install.. | Remove..

[ Product [ version [ status [ 1ssued [ Expires [ Mod= 10 [ Serial 2
ernal Developer  SR140 1.0 valid 02-Apr-2010  permanent FA4ECZFD36... ERKT10S: 15268
ernal Developer  SR140 1o alidl 26-Mar-2010  permanent FAAECZFD36... BRKT10S: 15130
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4. Select Install previously activated license... from the License
menu. The following screen appears:

Specify License File x|
Lonk in I@Desk{ap j + &I £f B

E!] My Computer
(S My MNetwork. Places

File name Fid | open |
Files of type: ILu:ense File*lic) j Cancel

¥

5. Browse to the location of the license file.
6. Highlight the filename, then click Open to activate your product.

Note: When the application is installed, an environment variable is
created called: BRKTD_LICENSE_FILE, which refers to a file
directory used by the License Manager to store license files.
For more information on environment variables, please refer
to your operating system documentation.
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Logging Information

The License Manager always provides logging information when
errors occur. The application logs all messages preceding the error
condition as well as messages following the error event. This log is
helpful to Dialogic Technical Services and Support when solving
problems.

In addition, you can execute the License Manager with the /d or --
debug option. For example, run brktlicmgr /din a command
window. Then the application logs all the information about the
installed licenses.

This text log file, called brktlicmgr.log, is stored in the application
directory.
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Managing License Files

The section contains the following instructions to manage the license
files:

Naming License Files on page 53

Backing Up Licenses on page 53

Removing Licenses on page 53

Re-Installing Your Product on page 54

Re-Installing Your Product on page 54

Restoring License Files on page 55
Re-Hosting License Files on page 57

You can find license files (*.lic) in the path specified by the following
environment variable:

BRKTD_LICENSE_FILE
The License Manager typically stores the files in this path:

C:\Program Files\Common Files\Brooktrout\

If you remove Ethernet network cards from your system, the license files
become invalid if the card has a license file node locked to it. To activate
the products, re-host the licenses (see Re-Hosting License Files on
page 57).

Note: If the ISV took the necessary steps, the license files are not
removed when you remove the application using the uninstall
option. Unless you manually remove the files, they are always
located in the following directory:

C:\ProgramFiles\Common Files\Brooktrout

The environment variable BRKTD_LICENSE_FILE is removed
when the Brooktrout SDK is uninstalled.

Do not copy other files into this directory. Doing so could
result in the Configuration Tool reporting errors.
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Naming License Files

All license files end with the .lic extension. One file can contain only
one license. The license filename is usually in either form:

dd-mmme-yyyy.lic
dd-mmm-yyyy-x.lic (next available number)

However, the license filename can be any filename with a .lic
extension.

Backing Up Licenses

Removing Licenses

To back up licenses, copy all *.lic files from the directory into a safe
location. Copying the license files back to the same directory restores
the licenses.

Typical directory:
¢:\Program Files\Common Files\Brooktrout\

The path to the directory containing the license files can be found in
the environment variable:
BRKTD_LICENSE_FILE

The License Manager provides the means to remove licenses.

>

1.

ok wbd

Follow the steps below to remove a license:

Start the License Manager by selecting the following:

Start — Program Files — Brooktrout — Brooktrout License Manager
The License Manager window appears.

Find the serial number of the license you would like to remove.
Left click the license.

Select Remove selected license from the License menu or click
the blue X with Remove... on the toolbar. A Confirm License
Removal screen appears.

If you are sure you want to remove the selected license, click Yes,
otherwise click No.
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7. A popup will appear indicating the serial number and file name
of the file which was removed.

8. The selected file will be renamed from licensefile.lic to
licensefile.lic.removed. This file is located in the directory which
the environment variable BRKTD_LICENSE_FILE (typically
C:A\Program Files\Common Files\Brooktrout\) refers to.

Re-installing a License

» Ifalicense was removed using License Manager, you need
to shut down License Manager and re-install the license
manually as follows:

Select Exit from the License menu to stop the License Manager.

Go to the directory that the environment variable
BRKTD_LICENSE_FILE

refers to and find the license file which was removed (typically
¢:\Program Files\Common Files\Brooktrout\). These files are in
the format licensefile.lic.removed.

3. Ifthere is more than one file that has been removed, then you will
need to open each of the removed files and locate the serial
number of the license which you would like to reinstall.

4. Once you find the file to reinstall, rename the
licensefile.lic.removed to licensefile.lic

5. Restart License Manager by selecting the following:

Start - Program Files — Brooktrout — Brooktrout License Manager
6. The license appears in the license manager window.

Re-Installing Your Product

If you want to simply re-install your product on the same computer
system after upgrading or replacing your hard disk or any other

upgrade that maintains your network card’s MAC address, you can
use the same license file without having to re-activate your product.

December 2010 54



Managing License Files

Restoring License Files

If anything ever happens to your computer that leads to corruption of
your software and the License File, retrieving another copy is a
simple procedure. To retrieve another copy of your License File,

1. Visit the Dialogic activation website at:
www.dialogic.com/activation

The following screen appears.

Dialzgic

Please Enter Your License Key

License Key™:

* Please enter the License kKey exactly as it appears. The same case and without any
spaces

2. Enter your original License Key (this can be found on your
License certificate) and click Submit. The following screen
appears.

Select tems to View

Hostid:

Select Product: 950-101-w34-30 1.0 SR140-30F

Filter Products

950-101-v34-30 1.0 SR140-30F
El Order || Mlode I |
[BRKTSS|[WID=7 CSOD4ECA1E 1 32953A595BA0B 140BE53052)|
[0950-101-v34-30 1.0 SR140-30F
El Order || Mrode I |
[BRKTSS|WID=7 CSD4EDA LE 1 3203A80SBA0E 14DESS05 2|
[1950-101-v34-30 1.0 SR140-30F
| Order || Mods 10 |
[BRKTSS|[WID=2010CF1BE31 1EQQE23F3601D66C 102E 17 <

ViEW[ COCisplay licenses only (no wrappers)

[[Logout | [ Home | [Help ]
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3. Click View Licenses. The following screen appears.

Select Items to View

Hostid:

Select Product: 950-101434-30 1.0 SR140-30F

Filter Products

F950-101-v34-30 1.0 SR140-30F

E Order Mode 1D
BRET3E|WID=7C5D4EDAIE13293A898BA0B 14DBSS0E82
O0950-101-v34-30 1.0 SR140-30F

E Order Mode 1D
BRET3E|WID=7C5D4EDAIE13293A898BA0B 14DBSS0E82
O0950-101-v34-30 1.0 SR140-30F

E Order Mode 1D
BRET3S|WID=910CF1B311E99E25F3691066C102E17 4

Vie""[ Obisplay licenses only {no wrappers)

4. In the Select Product window, select your product and then select
the appropriate Node ID. Click View. The following screen appears.

Deliver License

FEATURE 3R140 BRETD 1.0 permanent uncounted %
WENDOR_STRING=VoiceCh=0:FaxCh=30:Links=0:V34Enab=30: Adv3ph=0: AdwFax=30:T38Enab=30
HOSTID=VID=7CSD4EDAIE13293A895BA0E14DB56052 ISSUED=08-Nov-2007 4
SN="BRET35: 2122" TS_OK 3IGN="0893 F3BEC D985 2C75 1A0OE 3DAS
F91E 1BC7 016E EF10 2587 25D4 DOAS 21B8 ECCD 0898 CEFC SDFO 4
95D3 ESS90 SD15 C72Z0 €F6D DEE7 FSES §565 SDF6 4F73 6725 ASBA"

Save to File

Send t0: [pAginiti@dialogic. com

5. Click Save to File or click Email to have the License file emailed to
you. Follow the instructions Installing Licenses on page 49 to use
the License Manager application to install the license file.
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Re-Hosting License Files

To allow you to upgrade your computer to a new system or recover
from a network card failure, Dialogic allows you to “re-host” your
licensed software from one computer system to another. This process
involves returning your current license and receiving another one.

The activation center web site allows you to automatically re-host
your licensed software one time without technical support. For
subsequent re-hosts you will need to contact Dialogic Technical
Services and Support.

» Follow the steps below:

1. Visit the Dialogic activation website at:
www.dialogic.com/activation

The following screen appears.

Dialzgic

Please Enter Your License Key

License Key*:

* Please enter the License Key exactly as it appears. The same case and without any
spaces

2. Enter your original License Key (this can be found on your
License certificate) and click Submit. The following screen
appears
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Dialezgic

Generate. Re-Host or View Licenses

[ Generate Licenses ] l Re-host L,i\censes ] [ Yiew Licenses

3

* Generate License - to create a new license from your License Key; Re-Host License - to
transfer your license from one machine to another; View License - to view or download a
license you have already activated.

3. Click Re-host Licenses. The following screen appears.

In Order to Re-Host you need to 'Retum’ the license first by selecting the license and pressing the RETURN button.

Select Items to View

Hostid:

Select Product:

Filter Praducts

[¥1950-101-v34-30 1.0 SR140-30F
E Order Nods 1D
BRKT35|VID=7C504EDALE13293A896BA0B 14DB58082)
[1950-101-v34-30 1.0 SR140-30F

E Crder Node ID
BRKT3S|\VID=910CF1B311E99E23F3691D66C1D2E17 4|
[0950-101-y34-30 1.0 SR140-30F

Crder Node 1D
BRKT35|VID=910CF1B311E99E23F3691066C 1028174

Fetuin | ODisplay licenses only (no wrappers)

4. Select your product and click Return to return the license to

Dialogic. The following screen appears.
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Confirm your Selection

950-101-v34-30 1.0 SR140-30F
Order MNode 1D
BRKT35|WID=7C5D4EDA1E13295A898BA0B 14DE58082

5. Verify that the information on this screen is correct and click
Confirm. The following screen appears.

Select Items to Re-host

Select Product: 5950-101-34-30 1.0 SR140-30F
950-101-v34-30 1.0 SR140-30F
Last Hostid
WID=7ZED4EDALIE13293A898BA0B 14DB58082
License Type: Locked Uncounted
Mode ID Type: v
Mode ID:

[ Generate License ]
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6. In the Select Product box click the product for which you are re-
hosting. Select the Node ID Type and enter the Node ID. The
Node ID Type must be VID (Vendor Defined Node ID) if you are
using License Manager Version 2.0 or later. (Go to the Help
Menu, and click About ... if you are not sure of your version of
License Manager.)

Select Items to Re-host

Select Product: 950-101-v34-30 1.0 SR140-30F

950-101-v34-30 1.0 SR140-30F
Last Hostid
WID=7ZED4EDALIE13293A898BA0B 14DB58082
License Type: Locked Uncounted
MNode ID Type: A0 w
Made ID: Z23F3601D66CID2ELT4
Generate Licensi
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7. Click Generate License. The following screen appears.

Confirm your Selection

950-101-v34-30 1.0 SR140-30F
Last Hostid
WID=7ZED4EDALIE13293A898BA0B 14DB58082

License Type: Locked Uncounted
Mode 1D Type: WD

Mode ID: S10CF1B311E99E23F3691D66C10D2ELY 4

N

8. Click Confirm. The following license appears.

Deliver License

FEATURE SR140 BRETD 1.0 permanent uncounted %
WENDOR_STRING=VoiceCh=0:FaxCh=30:Links=0:V34Enab=30:Adv3ph=0: LdvFax=30: T38Ensb=30 \
HOSTID=VID=910CF1B311EQ9E23F3691D66C1DZE174 ISSUED=04-Jan-2008 4
SN="BEKT35: 26327 T3_OK SIGN="0BECS OSEC ASSE 2334 B372 1424 4
ODED FAT7E E3FA 7854A DEC4 54D3 2B2ZA EOSBE 9438 1DIE S963 CLDF 4
0OADB 5551 AD10 SDAT SDEE 7E17 EZES ESDZ AF18 ACA8 AT33 BCAl"

Sawve to File

Send to! [y fyiginiti@dialogic. com| Ema\\t!
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December 2010

Click Save to File to save the license file to your computer or click

Email to have the License file emailed to you. The following screen
appears.

Dialzgic

Deliver License

License has been sent to: bfulginiti@dialogic.com

10. Follow the instructions Installing Licenses on page 49 to use the

License Manager application to install the license file on the
appropriate computer.
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4 - Configuring Dialogice Brooktrout®

SR140 Software and Dialogic®

Brooktrout® TR1034 /Trufax Boards

This chapter describes how to configure the following products:

m Dialogic® Brooktrout® SR140 Fax Software

m  Dialogic Brooktrout® TR1034 Series and Dialogic Brooktrout®
TruFax® boards

Dialogic provides the following method for configuring the virtual
module:

m  Configuring in Wizard Mode on page 64 (adequate for most
configurations)

m .Advanced Mode on page 90.

However, this method has not been adapted by every ISV software
package. Instead, when this method is not used by your ISV
application, please skip this chapter and consult the documentation
that comes with your ISV application for the configuration of the
SR140 Fax Software.
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Configuring in Wizard Mode

This section describes how to use the Wizard Mode to configure
Dialogic® Brooktrout® Fax Software. You can use Wizard Mode to
get most typical systems up and running with minimal effort.

In Wizard Mode, after you answer the basic questions, the
Configuration Tool does the following.

m  Automatically creates the necessary configuration file
m Installs and starts the drivers, if required
m  Starts the Boston Host Service

Wizard Mode requires that all the modules be of the same kind. All
modules are configured identically, that is, the modifications to the
configuration apply uniformly to all the modules.

You can use Wizard Mode in a homogeneous configuration where:
m all the boards are of an identical type

or

B the system contains only SR140 virtual boards.

In a non-homogeneous configuration, the Configuration Tool will
automatically start in Advanced Mode.

» To use Wizard Mode:

1. Start the Configuration Tool if it has not already been started by
the Plug-and-Play installation procedure. See Running the
Dialogic® Brooktrout® Configuration Tool on page 95.
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2. The Welcome window appears.

with the networks in which they are deployed. There are
Wizard Mode

The tool will guide vou through the configuration, prompti

needed to get your praduct up and running. YWizard mode uses default values that will work in maost

situations.

Dia]ggic' Advanced Mode

deployment. This mode lets you modify the default param

to the 'wWizard Mode by restarting the tool.

box ta get a mare complete definition.

Click Mext to continue in 'wizard Mode or switch mode by clicking &dvanced Mode.

Welcome to the Brooktrout Configuration Wizard

Thiz wizard will help you configure your Dialogic Brooktrout hardware and software to communicate

Thiz mode is for users with a strong knowledge of the netwark parameters needed for the particular

access ko parameters not usually needed. IF you enter Advanced Mode, you can only switch back.

Context Senzitive Help - The Canfiguration Toal provides contest sensitive help far parameters
Tao access the contexst sensitive help, hold the cursor over the parameter input area to see a brief
parameter description, or right-click the parameter and select "what's this™" from the drop-down

twio ways to un the configuration tool:

ing you for the minimal infarmation

eters sef in the “Wizard Mode and gives

Advanced Mode Help |

< Back LCancel |

3. When the Welcome window appears, you can choose to click the

Advanced Mode button or the Next button.

¢ Advanced Mode

If you select Advanced Mode, the Configuration Tool exits
Wizard Mode and starts in Advanced Mode (see Advanced

Mode on page 90).
¢ Next

If you click the Next button, Wizard Mode continues and
creates the necessary configuration file after you answer the

basic questions.
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4. The System Report appears on the right-hand panel, then click
Next.

Brooktrout Configuration Tool - Wizard Mode

— System Report

|x

Hardware Information ™

| Board Information - Module 0x6

|Name ‘ Waiue

[ Boara hiame: [TR10G4+P4EV4EFHEG-2TI AN
|Number of Parts: ‘2

|Numher of Yoice Channels: ‘48

Dia.]@gic |Number of Fax Channels: ‘48

48 channel Yoice, 48 channel Fax,
%.711 Enabled, 2 T1 connections,

Description: ' 34, Universal PCI, H100, Ethernet
Ready.
[Switeh Type: [Hao0 i

Software Information

i . . 1 =]

Help | < Back I Nest > I LCancel |

This example shows the information for a T1 board.

5. Click Next and the following screen appears if the system detects
a board that supports both IP and PSTN.

Brooktrout Configuration Tool - Wizard Mode x|

Call Control Selection

This board can place and receive calls over an IP network or a telephone network. IF you are
going o place calls aver an IP network, then select IP. If pou are going to place calls over a
telephone network then select PSTH.

Dialegic

o« Bublic Switched Telenhang fehwork [PSTRE

£ Intemet Protocal [IP] Hetwork

Hep | <Back [ Wew> | concel |

6. If youwant to configure IP call control, select Internet Protocol (IP)
Network and refer to Configuring IP Call Control on page 68.
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If you want to configure PSTN call control, select Public Switched
Telephone Network (PSTN) and refer to Configuring PSTN on
page 86
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Configuring IP Call Control

» Follow the steps below to configure IP Call Control:

1. The following screen appears either after you select Internet
Protocol (IP) Network or if your system supports only IP Call
Control.

Brooktrout Configuration Tool - Wizard Mode x|

Protocol Selection

This product supports bwa standards for placing and receiving calls in an [P Netwark.

Pleaze zelect the IP Call Control pratocal used in pour netwark and click Mext to continue.

Dialegic s

" H323

Hep | <Bak [ Mets | Concel |

2. Select SIP or H.323. Click Next and the following screen appears
if your system is board-based. If your system is software based the

following step is skipped.

December 2010



Configuring in Wizard Mode

Brooktrout Configuration Tool - Wizard Mode x|

Board Ethernet Port Configuration

Far making calls over [P, you must configure the Ethermet port on each board.

 IP Signaling
- -
D]a‘leg IC- Board Module: 0x6, Ethernet Port #1:
IP &ddress: E .o o. 0
IP Metmask: o .0 o. 0
IP Gateway o .0 o.a

Help | < Back I Mext > I LCancel |

3. Configure the Ethernet Port for each board detected. Click Next
and the following screen appears if there are multiple IP
Interfaces detected in the system.

Brooktrout Configuration Tool - Wizard Mode x|

Network Interface Setup

There are multiple P Interfaces detected in the system. Please select the [P Interface that pou would
lke to use when making and receiving calls.

IF Interface e IP Interface

Dialegic

Click Mext to continue.

Help | < Back I Mext > I Cancel

4. Specify which network interface to use for IP calls.
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5. Refer to one of the sections below depending on which protocol
you want to configure:

Configuring SIP Call Control Protocol on page 70
Configuring H.323 Call Control on page 78

Configuring SIP Call Control Protocol

The section contains the following procedures.

Configuring Direct Routing by the Application on page 70
Configuring SIP Call Control with Gateway or IP-PBX on page 71
Configuring SIP Call Control with a Proxy Server on page 72

Configuring Direct Routing by the Application

If you chose to configure the SIP Call Control protocol the following
screen appears:

Brooktrout Configuration Tool - Wizard Mode x|

SIP Setup

In SIP protocal, calls can be routed in one of the following three ways:

Direct routing by the Application

when direct routing is used, the application will make calls by specifying a phone number
at an |P address. e.g. 973566121231 28.10.135.145,

Automalic routing to a Gateway or IP-PBX

“when automalic routing iz used, you configure the IP addiess of the gateway or IP-PBX where
all calls will be routed.

Dialegic

Dynamic routing by a Proxy Server

‘when dynamic routing through a prosy server is used, you configure the IP address of the prosy
server which will provide the IP address of the device to uge on a call by call basis.

Please select the routing method to be used:
& Direct routing by the Applicatior

= Automatic outing o a G atewsay or IP-PEX

= Dynamic rauting by a Prosy server

Help | < Back I Mewt > I Cancel |

» Follow the steps below to configure Direct Routing by the
Application.

1. Select Direct routing by the Application.
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2. There is no routing configuration required because the
application routes the call. Click Next and refer to Configuring
SIP Fax Setup on page 77

Configuring SIP Call Control with Gateway or IP-PBX

If you chose to configure the SIP Call Control, the following screen
appears.

Brooktrout Configuration Tool - Wizard Mode i

SIP Setup

In SIP protocol, calls can be routed in one of the following three waps:

Direct routing by the Application

When direct routing i used, the application will make calls by specifying a phone number
at an IP address, e.g. 973555121291 28.10.135.145.

Automalic routing to a Gateway or IP-PBX

Wwhen automatic routing is used, you configurs the |P address of the gateveay or [P-PBX where
all zalls will be routed.

Dia]eg ic' Dynamic routing by a Proxy Server

‘When dynamic routing through a proxy server is used, vou configure the IP address of the pro=y
zerver which will provide the |P address of the device to uze on a call by call basis.

Fleaze select the routing method to be used:

' Direct rauting by the Application

~ Dynamic rauting by a Proxy server

Help | < Back I Mext » I Lancel

» Follow the steps below to configure SIP Call Control with a
Gateway or IP-PBX.

1. Select Automatic routing to a Gateway or IP-PBX. Click Next and
the following screen appears.
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Brooktrout Configuration Tool - Wizard Mode x|

SIP Gateway/IP-PBX Setup

Enter the IP address, including the part number, of the Gateway or IP-PEX where all calls will
be routed. The port walue will defalt ta SOE0 if set to 0.

Primary G ateway: | M. o. 0.0 :|EI

Dialegic

Click Mest to continue.

Help | < Back I Hext > I Cancel |

2. Enter the Primary Gateway. Click Next and refer to Configuring
the SIP Registrar on page 75

Configuring SIP Call Control with a Proxy Server

If you chose to configure the SIP Call Control the following screen
appears.
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Brooktrout Configuration Tool - Wizard Mode x|

SIP Setup

In SIP protocol, calls can be routed in one of the following three ways:

Direct routing by the Application

When direct routing is used, the application will make calls by specifving a phane number
at an IP address, e.g. 9735551212E0128.10.135.745.

Aut: tic routing to a Gat or IP-PBX

When automatic routing iz used, you configure the |P address of the gateway or IP-PEX where
all calls will be routed.

Dia]eg ic' Dynamic routing by a Proxy Server

When dynamic routing through a proxy server is used, you configure the |P address of the prosy
server which will provide the IP address of the device to use on a call by cal basis.

Please selzct the routing method to be used:
" Direct routing by the Application

~ Automatic rauting to a Gateway or |P-PEX

(Ol

Help | < Back I Mest > I LCancel |

» Follow the steps below to configure SIP Call Control with a SIP
Proxy Server

1. Select Dynamic routing by a Proxy Server. Click Next and the
following screen appears.

Brooktrout Configuration Tool - Wizard Mode x|

SIP Proxy Server Setup

Enter the address of the Praxy Server where all callz will be routed. The address must be in
$HHHE S $HEE BHEPortM umber or hostname: PortMumber format. The :PartM umber iz optional.
The port value will default to 5060 if set to O or omitted.

Primary Prowy Server:

Dialegic

“I'ou may also specify additional Prosy servers for failover support. Under failover configuration,
when the primary Proxy Server is unreachable, all calls are routed to the next Proxy Server. [ this
Prowy Server also becomes unreachable, all calls are then routed to the next Proky Server and
zoon. Do pou want to specify additional Proxy Servers?

" Mo

Click Mext to cortinLe.

Help ¢ Back I Mest > I Lancel
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2. Enter the IP address of the Primary Proxy Server and select Yes
if there are additional proxy servers to configure. Click Next and
the following screen appears.

Brooktrout Configuration Tool - Wizard Mode x|

SIP Additional Proxy Server Setup

Enter the addresses of up to three additional Prosy Servers vou want to use in the box below.

The addresses must be in SR HER BRE:Pothurmber or hostname:Portiumber format. The
:Portiumber is optional. Please press Enter after each addiess. The order of addresses entered
will be the arder in which the Prosy Servers will be used for failover support. The port value

will default to GOB0 I set to O or omitted.

Dialegic

Help | < Back I Hests I Lancel |

3. Enter the IP address of any additional proxy servers. Click Next
and continue to the next step Configuring the SIP Registrar on
page 75
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Configuring the SIP Registrar

» When the screen below appears, you can configure a SIP
Registrar.

Brooktrout Configuration Tool - Wizard Mode x|

SIP Registrar Setup

A S|P Registrar is used for registering your current lacation sa that incaming calls can be routed
appropriately by a SIP Proxp Server

Do pou want ta register pour location with a SIP Registrar Server?

Dialegic

Help | ¢ Back I Nest > I Lancel |

1. From the screen above, select Yes to set up a SIP registrar. Click
Next and the following screen appears.
|

SIP Registrar Server Setup

Enter the the fallawing information for registering with the Primary Registrar Server. This
information can be obtained from your network Administrator.

Primary Registrar Server URL: I\
PFrirnary Registrar Server Address of Recaord: |

- -
D'Ia]gg 'Ic Frimam Registrar Server Usemame: I
PFrirnary Registrar Server Password: I

Address-of-Record: An address-of-record (A0R] is a SIP or SIPS URI that paints to & domain with &
location service that can map the URI ta another URI where the user might be available. Tppically,
the location service i populated through registrations. An AOR iz frequently thought of as the
"public address" of the user.

Click Next to continue

Help < Back I Hest > I LCancel
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2. Complete the information on this screen and click Next. The
following screen appears.

Brooktrout Configuration Tool - Wizard Mode 5]

SIP Registrar Server Setup - continued

“ou may also specify additional Registrar Servers for Failover support. Under failover configuration,
when the primary Registrar Server iz unreachable, all registration requests are sent to the next
Riegistrar Server. If this Registrar Server also becomes unieachable, all registration requests are
then sent to the next Registrar Server and o on.

Do you want ta specify additional Registrar Servers?
. ] .
Dialzgic ¢ 5
" No

Click Mext to continue.

Hop | <Back [ New> | Cancal |

3. Select Yes to configure additional registrar servers. The following
screen appears.
|

SIP Additional Registrar Server Setup

Enter the Uniform Resouce Locater [URL] addresses of up to three additional Registrar Servers
you want to use in the box below. Please press Enter after each URL. The order of the URLs listed
will be the order in which the Registrar Servers will be uzed for failover support,

Dialegic. i

Help | < Back I st s I Cancel |

4. Enter the IP addresses of the additional registrar servers. Click
Next and the following screen appears. Refer to Configuring SIP
Fax Setup on page 77

December 2010 76



Configuring in Wizard Mode

Configuring SIP Fax Setup

» When the screen below appears, you can configure Fax.
|

Fax Setup

This screen lets pou get the mazimum data rate that will be used for fax transmissions.

The two most common fax fransmission standads which govern the rate at which fax data is sent
are .17, which supparts rates up to 14,400 bps. and the newer .34 which supports rates up to
33,600 bps. While this product supports both standards, not all IP telephony gateways suppart the
more advanced V.34 standard. For this reason, selection of mazimum data rates higher than
14.400 bps should be made with same careful consideration. Unless vou are certain that the IP

] )
Dla]@g]c Telephony infrastructure within pour network. through which Fax calls will be made da nat Fail when

uging .34, the data rate of 14,400 will produce the best interoperability.

Masimum 5 Fae, b -

Click Mext to continue.

Help | < Back I Next > I LCancel |

1. Configure the fax transmission and the configuration is complete.
Click Next and refer to Applying Changes after the Configuration
is Complete on page 84.
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Configuring H.323 Call Control

You can configure H.323 Call Control three ways:

Configuring H.323 Direct Routing by the Application on page 78

Configuring H323 Call Control with a Gateway on page 79

Configuring H.323 Call Control with a Gatekeeper on page 80

Configuring H.323 Direct Routing by the Application

If you chose to configure the H.323 Call Control, protocol the

following screen appears.

H.323 Setup

Direct routing by the Application

at an |P address, e.g. 9735051212(212810.135.145.

A ic rouling to a Gals o1 IP-PBX

all calls will be routed

Dia-]eg ic Dynamic routing by a Gatekeeper

Please select the routing method to be used:

i vk

" Automatic routing to a Gateway or IP-PEx

" Dynamic outing by a Gatekeeper

In H.323 protocol. calls can be routed in one of the fallawing three ways:

When direct routing iz uzed. the application will make calls by specifying a phane number

When automatic routing it used. you configure the IP addiess of the gateway or IP-PBX where

‘when dynamic routing thiough a gatekeeper is used, you configure the IP address of the
gatekeeper which will provide, on a call by call basis. the IP address of the device to use.

Help |

¢ Back I Mext > I LCancel |

» Follow the steps below to configure Direct Routing by the

Application.
Select Direct routing by the Application.

This is no routing configuration required because the application
routes the call. Click Next and refer to Configuring H.323 Fax

Setup on page 82
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Configuring H323 Call Control with a Gateway

If you chose to configure the H.323 Call Control protocol the
following screen appears.

Brooktrout Configuration Tool - Wizard Mode x|

H.323 Setup

In H.323 protocol, calls can be routed in one of the following three ways.
Direct routing by the Application

“when direct routing is used, the application will make calls by specifying a phone number
at an IP address, e.g. 87356651 212E128.10.135.145.

A ic routing to a Gat or IP-PBX

‘when automahic routing is used. pou configure the |IP addiess of the gateway or IP-FPB where
all calls will be routed.

Dialegic

Dynamic routing by a Gatekeeper
“hen dynamic routing through a gatekeeper is used. you configure the [P address of the
gatekesper which will provide, on a call by call basis. the IP address of the device to use.

Please select the routing method to be used:

" Direct rauting by the Application

& Piiomaticiouing o a Haleay or [PEER

= Dynamic routing by a Gatekesper

Help | < Back I MHest » I Cancel |

» Follow the steps below to configure H.323 Call Control with a
Gateway or IP-PBX.

1. Select Automatic Routing to a Gateway or IP-PBX. Click Next and
the following screen appears.

o
H.323 Gateway/TP-PEX Setup

Enter the IP addiess of the Gateway/|P-PBX where all calls will be routed. The port value
vaill default to 1720 if set to 0.

Primary Gateway: .0 o. 0 ;o
Dia]@g ic_ Click Next to contire.

Help < Back I Meut > I Lancel
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2. Enter the Primary Gateway IP address. Click Next and refer to
Configuring H.323 Fax Setup on page 82.

Configuring H.323 Call Control with a Gatekeeper

If you chose to configure the H.323 Call Control protocol the
following screen appears.

Brooktrout Configuration Tool - Wizard Mode 1'

H.323 Setup

In H.323 protocol, calls can be routed in one of the fallowing three ways:

Direct routing by the Application

When direct rauting is used, the application will make calls by specifying a phone number
4t an |P address, e.g. 97366612121 28.10.135.145

Automatic routing to a Gateway or IP-PBX

“When automatic routing is used, you configure the IP address of the gateway or IP-PEX where
all calls will be routed.

Dialegic.

Dynamic routing by a Gatekeeper

‘when dynamic routing through a gatekeeper is used. vou configure the |P addiess of the
gatekeeper which will provide, on a call by call basis. the [P addiess of the device to use.
Please select the routing method to be used:

" Ditgct routing by the Application

" Automatic routing to a Gateway or |P-PE

(ol

Help < Back I Mesxt » I LCancel
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» Follow the steps below to configure H.323 Call Control with a
Gatekeeper:

1. Select Dynamic Routing by a Gatekeeper. Click Next and the
following screen appears.
|

H.323 Gatekeeper Setup

Enter the IP address, including port number, of the primary Gatekesper where all calls will be routed.
The port value will default to 1720 et to 0

Primary Gatekeeper: E.o.o0. 10 IU_
Dialegic

Click Mext to continue.

Help | < Back I Next > I Cancel |

2. Enter the IP Address of the Primary Gatekeeper. Click Next and
the following screen appears.
|

H.323 Gatekeeper Setup - continued

You may also specity backup Gatekeepers that can be used for failover situations. IF the primany
Gatekeeper cannot be reached, all calls will then be routed ta the next backup Gatekeeper that
is available

Do you want to specify backup Gatekeepers?

Dialegic © e

1~ No

Click Mext to continue.

Help < Back I Mewt > I Cancel
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3. Select Yes to specify additional gatekeepers. Click Next and the
following screen appears.

Brooktrout Configuration Tool - Wizard Mode 5[

H.323 Backup Gatekeepers Setup

Enter the IP addresses of up to five backup Gatekeepers pou want to use in the box below.
The IP addresses must be in i . #HE BHE PortMumber format (PortNumber is aptional).
Flease press Enter after each IP addiess. Backup Gatekeepers will be used in the order in
which they are listed below. The port value will defsult to 1720 i set to O or amitted

Dialegic | | »

Help | < Back I Hezt > I LCancel |

4. Enter the IP addresses of the additional gatekeepers. Click Next
and refer to Configuring H.323 Fax Setup on page 82

Configuring H.323 Fax Setup

» When the screen below appears, you can configure Fax.

Brooktrout Configuration Tool - Wizard Mode x|
Fax Setup

This screen lets pou set the maximum data rate that will be uzed for fax transmissions.

The two most common fax transmission standards which govern the rate at which fax data is sent
are .17, which supports rates up to 14,400 bps, and the newer . 34 which suppaorts rates up to
32,600 bps. While this product supports bath standards, not all IP telephony gateways suppart the:
more advanced V.34 standard. For this reazon, selection of maximurm data rates higher than
14,400 bps should be made with some careful consideration. Unless you are certain that the I

- -
Dla] @g lc T elephony infrastructure within your network. through which fax calls will be made do nat fail when

using . 34, the data rate of 14,400 will produce the best interoperability.

Mo 5t e, s -

Click Mest to continue:

Help < Back I Next > I LCancel
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1. Configure the fax transmission and the configuration is complete.
Click Next and refer to Applying Changes after the Configuration
is Complete on page 84.

Brooktrout Configuration Tool - Wizard Mode x|

Congratulations!!! Configuration complete.

IF you are not sure sbout the selections you made, you may go back and change them or
click Cancel and no changes will be saved

- 'I - IF you are satisfied with pour selections click Apply to save the configuration and initialize
ialegic. |

IF you want to save the configuration and exit without initializing the boards, click on
Sawve and Exit

Save and Exit Help < Back I Apply I LCancel

December 2010 83



Configuring in Wizard Mode

Applying Changes after the Configuration is
Complete

» Follow the steps below to save apply the changes.
|

Congratulations!!! Configuration complete.

If you are not sure about the selections you made. vou may go back and change them or
click Cancel and no changes will be zaved

- 'I - If you are satisfied with your selections click Apply to save the configuration and to initialize
.Ia. eg‘lc the boards,

If you want to simply save the configuration and exit without intializing the boards, click on
Save and Exit

Sawve and Exit I Help I < Back I Apply I LCancel

Click either Save and Exit, Help, Back, Apply, or Cancel.

¢ Save and Exit
+ Save the configuration and Exit without initializing the

modules.
¢ Help
+ Displays help for the Configuration Tool.
¢ Back
+ Displays previous page.
¢ Apply

+ Saves the configuration and initializes the modules.
¢ Cancel
+ Does not save the configuration and exits.
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2. Click Apply and the board is initialized and configured. The
following screen appears.

Brooktrout Configuration Tool - Wizard Mode x|

The Dialogic Brooktrout hardware on pour system has been successfully
Configured and Initialized.

Dialegic.

Help < Back I Finish I LCancel
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Configuring PSTN

Protocol Options

Dialogic recommends that you accept the defaults that are based on
the modules the Configuration Tool identified in your system. In this
example, the module uses the T1 ISDN protocol.

Note: In Wizard Mode all the ports of all the modules will be
configured with the same port setting.

December 2010

Brooktrout Configuration Tool - Wizard Mode X

The settings on this screen will impact all Dialogic Brooktrout boards in your system
Please select the country:
County: [usa fomo =l
Diglagic iecommends wsing the default port settings.
To see more configuration infarmation, click the Shaw Details button.

Protocal Options: [ REETRL] *| Show Details > |

Dialegic
Help < Back I Mext > I Lancel
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3. Click the Show Details >> button.
Note the details of the protocol chosen by the Configuration Tool.

Protocol Details

The protocol details appear in the panel below the Protocol Options.
The options are dependent on the protocol chosen.

This example displays the options for the T1 ISDN protocol.

See the Configuration Files in Volume 6 of the Bfv API Reference
Manual for more information about the protocol parameters.

Note: In wizard mode all the ports of all the modules will be
configured with the same port setting.

Brooktrout Configuration Tool - Wizard Mode x

The zettings on thiz screen will impact all Brooktrout boards in your system.

Fleaze zelect the country:
Cauntry: Jusaomop |

Brooktrout recommends uzing the default port settings.
To see more configuration information, click the Show Details buttan.

Pratocol Optiong: | Analog j
—&nalog
- ] -
D.!a- @glc- Praotocol File: IEI:\Brooktrout\Boston\config\ana EI =
Country Y ariant File: IEI:\Brooktrout\Boston\config\usB EI
W a DID) Digts: [0 0 J——— 25
DID Offset: [0 0 )———— &5
Enable Caller ID: IYes j
Mumber of Rings: I z @ 'J— 255
Enable Loop Reversal For Connect: IND j LI
Help | < Back Mest » | Lancel |

4. Click Next.
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The following screen appears.

Brooktrout Configuration Tool - Wizard Mode |

Congratulations!!! Configuration complete.

If you are not sure about the selections you made, you may go back and change them or
click Cancel and no changes will be saved.

- - If you are satisfied with your selections click Apply to zave the configuration and to initialize
lla. eg .lc. the boards.

If yau want to simply save the configuration and ext without initializing the boards, click an
Save and Exit

Save and Exit | Help | < Back I Apply I Lancel |

5. Click either Save and Exit, Help, Back, Apply, or Cancel.

¢ Save and Exit
+ Save the configuration and Exits without initializing the

modules.

¢ Help

+ Displays help for the Configuration Tool.
¢ Back

+ Displays previous page.
¢  Apply

+ Saves the configuration and initializes the modules.
¢ Cancel

+ Does not save the configuration and exits.
6. The Finish window appears if you selected Apply.
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Brooktrout Configuration Tool - Wizard Mode x|

The Dialogic Brooktrout hardware on your system has been successfully
Configured and Initialized.

Dialegic.

Help | ¢ Back I Finish I LCancel

7. Click Finish to complete the configuration.
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Advanced Mode

Advanced Mode Window

If you have different types of Dialogic® Brooktrout® modules in your
system or you want to configure your identical modules differently,
you must use Advanced Mode:

®m  When the Dialogic® Brooktrout® Configuration Tool detects that
you have different modules, it starts in Advanced Mode.

®  When you start the Configuration Tool in Wizard Mode, you can
move to Advanced Mode immediately by clicking the Advanced
Mode button.

The Advanced Settings parameters for all module types are
presented in logical groups. The ordering of the groups is
alphabetical. The ordering of parameters within a group is according
to their relative importance.

Most parameters are hidden unless you click Show Advanced.
Generally, a user does not need to change the advanced parameters.
See Call Control Parameters on page 104.

When you enter Advanced Mode, the Brooktrout Configuration Tool -
Advanced Mode window appears.

4% Brooktrout Configuration Tool - Advanced Mode =]
File View Options Help
fat = = = 3 ?
Haome Back et Save  Apply | License Help

= E_rooktrout [Baoston Hast Service - Running)
- Diiver Parameters [l boards]

Mate: i you are intending to configure an SR140 only, you rmust first activate a license

i BT Call Parameters (Al boards) using the License Manager.
(1 Call Control Parameters
Db Module 0x2: TR 094+PEVEF-0L This page contains essential information to use the tool effectively. You can get to this
- Module 0x3: TR1034+PAVAF-28 page any time by clicking on the Home icon on the toolbar. The user inteface consists of
Module Oud: TR1024+P 4 4F-28 two views: (a) the explorer view and (b} the content view.

o Module Dx41: 5R140
] IP Call Control Modules
LGP

The explorer view allows you to navigate through the various configurable components of
Erooktrout Hardware and Software. The content view containg either informational content
such as this page or controls that allow you to fine tune the Brooktrout compaonents

In this mode you can:
* Edit call control configuration per module.
= Edit the btcall parameters
* Edit the device driver parameters.
* Save the configuration information
* And finally apply the configuration.
Flease note that you must apply the configuration information for the changes to take
effect. The apply action is available from the toolbar as well as from the Options menu.

Under normal conditions (that is, all Brooktrout hardware installed on your system has the
same ship level number programmed on them), the configuration tool should come up in
the Wizard Mode. It can also be launched explicitly to come up in the advanced mode
by using fa or --advanced command line option. If you did not specify this option and the
tool came up in in this mode, it is because hardware detected by the tool required

idmrdifientinn e tha haet cwstams hae meaen dhan nne buse of Beaalteait kavdunrn madale 1)
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Navigating in Advanced
Mode

Advanced Mode Menus

» To navigate in Advanced Mode use the menus and buttons on
the tool bar and the tree view on the left panel of the dialog
boxes.

Select one of the following to view the accompanying right panel
information:

*

Select Brooktrout to display the welcome window, if you are
not already there.

Select Driver Parameters to display the Driver Parameters
dialog box.

For sample values, see Driver Parameters (All boards) on
page 93.

Select BTCall Parameters to display the BTCall Parameters
dialog box.

For sample values, see BTCall Parameters (All boards) on
page 102.

Select Call Control Parameters to display the Call Control
Parameters dialog box.

For sample values, see Call Control Parameters on page 104.
Select IP Call Control Parameters to display the IP Call Control
Parameters dialog box.

For sample values, see IP Call Control Modules on page 111.

The following menu items are available in the Advanced Mode

window:

The File menu allows you to exit from the Configuration Tool.

The View menu allows you to choose the previous or next
window.

* & 6 ¢ o o

The Options menu allows you to:

Choose to apply and/or save the configuration.
Reconfigure the driver.

Launch the Dialogic® Brooktrout® License Manager.
Configure the IP Stack.

Edit Trace Connections Settings.

Set your preferences for the locations of the btcall.cfg and
callctrl.cfg configuration files, the firmware, and log files.
The Preferences dialog box is shown in Getting Help From the
Dialogic® Brooktrout® Configuration Tool on page 97.

Display the toolbar.
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Advanced Mode Buttons

The Help menu provides the following options:

+ Access to the Configuration Tool Help Index Contents tree.

* Access to the Configuration Tool Help Index tab where you
can navigate through the Help index entries.

¢ Search tab where you can look for any text entry.

* About provides version and copyright information for the
Configuration Tool.

The Advanced Mode window contains these buttons:

Select the Home button to go to the welcome window if you are
not already there.

The Next and Back buttons take you to the next or previous
pages, respectively.

The Save button saves your configuration.

The Apply button installs, starts or stops the Boston Host

Service. It also saves your configuration to the appropriate
configuration file.

If driver parameters were modified, it dynamically reconfigures
the drivers on a PnP operating system.

The License button launches the Dialogic® Brooktrout® License
Manager (bkrtlicmgr.exe).

The Help button displays help for the Configuration Tool in any
mode.
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Advanced Mode

Driver Parameters (All boards)

Click on Driver Parameters (All Boards) in the left panel to display the
Driver Parameters in the right panel.

4% Brooktrout Configuration Tool - Advanced Mode
File Wiew Options Help

o [m] |
&« » | H &2
Home Back  Heqt Sawe  Apply | License | Help
(= Brookliout (Boston Host Service - Runningl | — Dyiver Parameter
i et Pararnet ]
BTCall Parameters (4 boards) e e =
(=) Call Control Parameters e Enate: IND J
- Module 045 TR1034+P48V4BFHG2 History P
Modude 0d1: GR140 b relEmetet
(=) IP Call Control Modules History Gize: I1024000
5P
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Reconfigure Drivers Right-click on Driver Parameters (All Boards) in the left panel to

reconfigure the driver.

This option dynamically updates the driver parameters by calling
reconfig on a PnP system.

4 Brooktrout Configuration Tool - Advanced Mode

_lolx|
File VYiew Options Help
o | & = & LY
Home Back  Hest Save  Apply | License Help
[=)- Brooktrout [Boston Host Service - Funning] | - Diiver Parameter
¢ figure
- BTCall Parameters [All boards £
tory Enable: hd
- Call Control Parameters ¥ INO J
- Module 0x6: TR1034+P48Y48FHG-2 Histor P
- Module 01 GR14D AR
&l IP* Call Contral Modules History Size: I1 123000
Logp
4 I ©
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Running the Dialogic® Brooktrout® Configuration

Tool

When you start the Configuration Tool for the first time, you may get
a Preferences Dialog box pop up. Only change the locations for the
various files used by the Configuration Tool when requested by your
application.

Brooktrout Configuration Tool - Preferences

C:ABrooktrouthBostonhconfigh F
C:ABrooktrouthBostonhconfigh |:
C:A\BrooktroutsBoston“driver. |:

C:MBrooktrout'Bostanhfv F

futomatic &

When the Configuration Tool detects an IP-enabled device, it
displays the Configure IP Stack dialog box. Check with your network
administrator whether you will use the SIP or H.323 IP call control.
If you don't know yet, select “Both (SIP and H323)” so that both
protocol stacks get installed.

Configure IP Stack

®  None - IP stack not installed
m  SIP - SIP stack installed (default)
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m  H.323 - H.323 stack installed
m  Both (SIP and H.323) - Both SIP and H.323 stacks installed.
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Getting Help From the Dialogic® Brooktrout® Configuration
Tool

The Dialogic® Brooktrout® Configuration Tool provides context
sensitive online help for parameters. The Help displays the purpose

and description of the parameter including the default value and
range, if applicable.

m  Hold the cursor over the parameter input area to see a brief
parameter description.

#% Brooktrout Configuration Tool - Advanced Mode

(O] ]
File “iew Options Help
@ | @& = © 53 %
Home: Back  Hest Save  Apply | License Help
[=)- Brooktrout (Boston Host Service - Running] General Information  Parameters

~ Diriver Parameters (Al boards)
- BTCall Parameters (Al boards)

IF Call Contral Madule: EQ 4|
[=I Call Control Parameters
- Module Ox41: SR140 IF Interface |SME EtherPower |1 10/100 NDIS 4.0 Minipart Drive = |
IP Call Control Modul
= ;IF ol Lowest P Part Number: [56000
Highest IP Port Number 700 [media_part_min) Specifu the lowest IP port number t
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m  Right-click the parameter drop-down box to get a more complete
definition for Configuration Tool parameters.

The What's This? popup menu appears:

% Brooktrout Configuration Tool - Advanced Mode

)= =] B3
File “iew Dptions Help
il = =5 = 2
Home | Back M= | Save Apply | Licenss | Help
=~ Brookuout [Boston Host Service - Aunning] | | General Information Parameters
Diiver Parameters (&) boards)
BTCall Parameters (&)l boards) |P Call Contral Module: Ig\p :I
(=} Call Control Parameters
© Module Dx41: SR140 IP Interface ISME EtherPower Il 10/100 NDIS 4.0 Miniport DriszI
= Cal ControlModtes Lowest I Fart Humber | S

Highest IP Port Number: 57000

m Left-click the What's This? popup menu for a definition like the
following. You can resize this text box, if necessary.

Help - Lowest IP Port Humber

| [media port min] This parameter 3ets ﬂ
the lowest IP port rmumbher that the
module can use for media transmissions.

[

Advanced Mode Menus » The following menu items are available in the Advanced Mode

window:

The File menu allows you to exit from the configuration tool.

The View menu allows you to choose the previous or next
window.

®  The Options menu allows you to:

¢+ Choose to apply and/or save the configuration.
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* & o o

Reconfigure the driver.
Launch the Brooktrout License Manager.
Configure the IP Stack.

Set your preferences for the locations of the btcall.cfg and
callctrl.cfg configuration files, the firmware, and log files.
The Preferences dialog box is shown in Getting Help From the
Dialogic® Brooktrout® Configuration Tool on page 97.

Display the toolbar.
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m  The Help menu provides the following options:

+ Access to the Configuration Tool Help Index Contents tree.

* Access to the Configuration Tool Help Index tab where you
can navigate through the Help index entries.

¢ Search tab where you can look for any text entry.

* About provides version and copyright information for the
Brooktrout Configuration Tool.

Advanced Mode Buttons » The Advanced Mode window contains these buttons:

Home button to go to the welcome window if you are not already
there.

m  Next and Back buttons take you to the next or previous pages,
respectively.

Save hutton saves your configuration.

Apply button installs, starts or stops the Boston Host Service. It
also saves your configuration to the appropriate configuration
file.

If you modified driver parameters, it:

*+ Dynamically reconfigures the drivers on a Plug and Play
(PnP) operating system.

+ Installs the Boston Host Service if the service is not
installed.

+ Stops the Boston Host Service if the service is not running.
¢ Starts the Boston Host Service.

License button launches the License Manager (bkrtlicmgr.exe).
Help button displays help for the Configuration Tool in any
mode.

Reconfigure Drivers Right-click on Driver Parameters (All Boards) in the left panel to
reconfigure the driver.

This option dynamically updates the driver parameters by:

m Calling reconfig on a PnP system.
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#y.Brooktrout Configuration Tool - Advanced Mode

¢ - Module x4 SR140
=+ IP Call Contiol Modules
siP

December 2010 101



Running the Dialogic® Brooktrout® Configuration Tool

BTCall Parameters (All boards)

Debugging Disabled

Click on BTCall Parameters (All Boards) in the left panel to display
the BTCall Parameters in the right panel. No BTCall Parameters
need to be changed, except when debugging is required. The country
parameter is not used for the SR140.

Debugging Options

When debugging is disabled all the BTCall Parameters
debugging-related parameters are grayed out.

5 Brooktrout Configuration Tool - Advanced Mode M=l 3
File ‘iew Options Help
w [ & = @ 53 ?
Home Back  [deqt Save Apply | License Help
=1 Brooktiout [Boston Host Service - Running) || BT Call Parameter
- Diiver Parameters [All boards)
- BTCall Parameters 4]l boards] Country Telephony Parameter File: IBT_CPAHM.CFG @"‘I
=1 Cal Control Parameters
Module Ds41: GR140 Couniy: [usa o] |
= P Lo ontcl Hoshies Masimum Tinen, sec [0 ——
Debug
AP Debugging:
st Debua Log File ame [F-SB rmokiraut Bostorhutis\winntibinteor | 3] 2 |
Sricl et g Fie e | 1_1 ﬁl
e Debug File Siee [10000000
Trace Bl AP Fuction G2l [Disable =l
Show Advanced 5>
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Debugging Enabled The Bfv API Debug file is the main Brooktrout log, capturing debug
information about faxing.

When you enable Bfv APl Debugging, you need to specify a file name
to write the Brooktrout debug information to. You can even specify a
second file name, and set the size of the first file so that a second file
is created when the first file has reached the specified size.

When you enable Bfv APl Debugging, and you enable “Trace Bfv API
Function Calls”, you will get the following info added to the log file:

m  Trace the entry to each Bfv API function call.
m List the parameter passed into a function.
m  Trace the exit from each Bfv API function call.

See the right panel for specific debug parameter information.

% Brooktrout Configuration Tool - Advanced Mode O] x|
File View Options Help
Al & = =] Sy ?
Home Back  [=st Sawe  Apply | License Help
[=)- Broaktrout [Boston Host Service - Running) | —BTCall Parameter
i Driver Parameters [All boards)
.~ ETCal Parameters (4]l boards] Cauntry Telephony Parameter File: IBLEPAHM CFG EI
() Call Control Parameters
| Module Dx41: SR14D Country [usa oma = |
B ot Contol Moddes Masimum TimeaLt, sec: 70— 98
Debug
APl Debugging: Enabled >
Tt Debug Log File Mame: [EBroakirauBostortutisainntionteor | o2 Zp|
2nd Debug Log File Hame: [ = %l
I Eimuin et e Size |1DDDDDDD
Trace Bfv API Function Calk: [Disable =1
Show Advanced »> I

For more information about the Show Advanced >> button, see
Advanced Settings on page 127.

Note: Most users never need to alter the Advanced Settings
parameter values.
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Call Control Parameters

Click Call Control Parameters in the left panel to display the Report
tab in the right panel.

Reporting and Debugging (Tracing)

Report Panel The Report tab displays the Call Control Parameters port
configuration information.

#% Brookbrout Configuration Tool - Advanced Mode
File ‘“iew Options Help

98 [=1 |5
o | & = | 3 =
Haomne Back fiewt Save  Apply | License Help
- Braoktraut (Baston Host Service - Rurning] | Report | Trat:mgl
Driver Parameters (A1l boards]
- BTCall Parameters (&l boards)
[=1- Call Control Parameters C :
all Control Port Configuration
- Module Oxd1: SR140 9
- 1P Call Control Modules
-~ 5IP Board Information - Module 0341
Name ‘ Vatue
Board Name: [sR140
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Tracing Panel

The Tracing tab displays the Call Control Tracing debug parameters.
Turning the parameters on will create a call control trace, sometimes
called ECC-trace, which captures all call related debug information,
similar to call setup and call tear down of the SIP or H.323 call.

5 Brooktrout Configuration Tool - Advanced Mode O[]
File “iew Options Help
@ &« =+ | = &
Home | Back Mest | Save Appy | License | Help
= Brookirout [Boston Host Service - Furning] | | Repan | Tracing |
- Diriver Parameters (A1 baards]
i+ BTCall Parameters (4]l boards] Advanced Settings
) Call Contral Parameters Do not change these parameters unless you have
i e Module 0xd1: SR140 been instructed to do so
)+ IP Call Control Modules
~SIP AP Trace Level None i
Host Module Tracs Level INDHE ﬂ
Intemal Trace Levet [ane |
IF Stack Trace Level [Mane =l
L34 Trace Level [Nane |
L4-L3 Trace Level INone ﬂ
Mawimurn Number of Trace Files: T 1 [—— 933
Masimum Trace File Size, MB [10
Trace File Name: Iecc.\og ﬂ él

Note: Do not change any of these parameters until you have
consulted with Dialogic Technical Services and Support. See
Getting Technical Support on page 12.

Module Tab Settings

Click the module name in the left panel tree view to modify
information about each module.

SR140 modules features and number of channels depends on the
license installed on the user system. You can obtain, install, and
update the license using the License Manager utility. When you
have installed multiple licenses, you will still typically see only one
SR140 module. So, licenses get added up to look like a single module.

Note: A special demonstration license is available in either a single-
or two-channel configuration that will run for a 30 day period.
Contact your Dialogic sales representative to obtain this
license.

Products with demonstration licenses run with limited
functionality. Please note that only one demonstration license
may be used at a time. Demonstration licenses have incoming
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and outgoing fax pages overlaid with a Demonstration
watermark. Once a demonstration license is upgraded to a
permanent license, there will be no watermark on the
incoming or outgoing fax pages. You can upgrade the
demonstration license to a permanent license by activating
new license keys without having to re-install the software.

December 2010 106



Running the Dialogic® Brooktrout® Configuration Tool

General Information Tab
for SR140

The Apply button on the toolbar starts the Boston Host Service to
initialize the module. See Advanced Mode Buttons on page 100.

The License button on the toolbar launches the License Manager

(bkrtlicmgr.exe).

Use this feature to query the SR140 Fax Software licensing. The
following window shows a permanent license:

#% Brooktrout Configuration T ool - Advanced Mode

=1ES
Fil= View Options Help
Zaf = 2 2
Home Back Sawe Apply  License Help
= Bracktiout (Boston Host Service - Running) | [F Beneral Information | Parameters |
Driver Parsmeters (Al boards)
BTCall Parameters [4ll boards)
1 Call Control Parameters =
i 5 Licensing Information I—
= IP Call Control Modules
el Product SR140
Version 1.0
Status License(s) are activated and installed
Humber of Channels 0
Feature Information [}3
Hame Humber of Licenses
“oice Channel(s) o
Fax Channei(s) B
Port(s) o
“+34 Enabled Channel(=) o =
dvanced Spesch Enabled Channei(= o
dvanced Fax Enabled Channel(s) 50 =l
H -+ Brooktrout Configuration Tool - Advanced Mode: . =1}
' File WView Options Help
= = &
Home | Back [Mewt | Save  Apply | License | Help
[ Brookirout Boston Hast Service - Running) | [ Genersl Information | Paramsters |
- Driver Parameters (41l boards)
{ BTCall Parameters (1l boards)
E} Call Control Parameters =
i e Madule 0x2: TR1034+PEVEF-BL Licensing Information =
- Module 0x3: TR1034+P4V4F-28
- Module Dxd: TR1034+P4v4F-28 [Product 3T
: [ 1. F140
! =1 IP Call Contiol Modules ension 5D
- SIF Status License(s) are activated and Installed.
2 Humber of Channels 2
!
License Type Demonstration
|
i Feature Information
[Hame Humber of Licenses
“aice Channel(s) 2
Feue Channel(s): 2 foe
Port(s) 0
W34 Enablad Channel(s): 2
Advanced Speech Enabled Channel(s): [ =
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Virtual Module - Not An SR140 module displays in the General Information tab even when
Available there is no valid license installed.

After Use License Manager utility to install the license displays, you
can click the icon to invoke the License Manager utility

(brktlicmgr.exe).
# Brooktrout Configuration Tool - Advanced Mode _[O] x|
File View Options Help
e R = o | 2
Home Back  Mexst Save  Apply | License Help
- Brookirout [Boston Host Service - Stopped) | General Information |
i Driver Parameters [All boards)
i ElIlﬁcagz?glﬂg::;:elill‘:ﬂa'ds1 Use Licsiss Manager utiiy to instal the iosnss. £3
B irtual Module -
Licensing Information
Product SR140
Version 1.0
There is no license installed on your system
status Laroe Ho (s et il o e (s
Humber of Channels I
Parameters Tab for The Parameters tab displays the call control module type, Media IP
SR140 Interface and IP port number information. You have to choose the IP
call control type and you have to set the IP Interface.
[ brooktrout Configuration ool - advanced Mode 1ol
File Wisw ©Options Help
G | & = &
Home | Back  fleqt Save Apply | License | Help

=1~ Brooktiout (Baston Host Service - Stopped]

General Information  Paramsters
Diriver Parameters (&l boards]

s o sostck] 1P Call Contiol ockle -
[=)- Call Contral Parameters
Module 0x41: SR140 Media IP Interface: I[- 1 Inkel(R) PRO/1000 MT Hatwork, E-j
IP Call Control Modul
= . ;,p erimandes Lawest [P Port Mumber, [5e00n

Highest IP Port Number [57000
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IP call control module

The options are SIP or H.323 as call control protocol for your IP
calls. Choose the IP option to associate this Call Control Type
with the Brooktrout virtual module. Please check with your IP
provider.

Media IP Interface

Specifies the identity of the device on the PC with the IP interface
that the virtual module can use for sending Fax Over IP (T.38 and
RTP) messages and Voice Over IP (RTP G.711) packets. Set the
value of this parameter to the name of any device in the PC with
an IP interface. Lists the network cards in the fax server and
their IP addresses - select the network card you want to use for
your FOIP traffic and give this network card a static IP address.
Contact your network administrator to assign a static IP address
to this Ethernet port since DHCP- dynamic host configuration
protocol is currently not supported by Dialogic. If DHCP is used
on the interface it can work, but only when the IP address does
not change while the SR140 virtual module is running. If you do
not provide a value (blank string), the virtual module chooses the
first interface in the PC to send its messages. The format for the
value provided in this parameter is: The name of the IP device
(Global Unique IDentifier (GUID)) followed by a colon (:)
character followed by the index number of the device's IP address,
For example: {4AD36E96E-E325-11CE-BFC1-08002BE10318}.0
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Note: Currently, the Bfv API only supports the GUID
information on Windows® operating systems.

Value Type: character string (up to 256 characters)
Default: <blank> (the virtual module uses the first
interface in the PC for sending IP messages)

Lowest IP Port Number

Specifies the lowest IP port number that the module can use for
media transmissions. Set this value to a value 1000 below the
value specified for the media_port_max parameter. Valid values

are:

Range: 1024 - 64535

Value Type: decimal

Default: 56000 (sets this value as the lowest port number)

Highest IP Port Number

Specifies the highest IP port number that the module can use. Set
this value to a value 1000 above the value specified for the
media_port_min parameter. Valid values are:

Range: 2024 - 65535
Value type: decimal
Default: 57000 (sets this value as the highest port number)

#% Brooktrout Configuration Tool - Advanced Mode

(=~ Brooktrout (Boston Host Service - Rurning)
- Driver Parameters (A1l boards]
TCall Parameters (2l boards]
rtiol Parameters

S -
SMC EtherPower 1 10100 NDIS 4.0 Minipart Dnvs
Control Modules
ik
57000

December 2010 110



Running the Dialogic® Brooktrout® Configuration Tool

IP Call Control Modules

» Click IP Call Control Modules on the left panel to display
information about any IP-enabled modules:

IP Call Control Modules Both SIP and H.323 are supported for the call control over IP.

Details

A Brooktrout Configuration Tool - Advanced Mode
File View Options Help

=] 4
il & = =] oy ?
Home Back =S Save  Apply | License Help
[=- Brooktraut (Boston Host Service - Running) .
Diiver Parameters (4l boards] IP Call Control Modules Details

ETCall Parameters (&)l boards)
[=- Call Contral Parameters
Module 0x41: SR140
x " Name

IP Call Control Module Information - Module 0x1

Value
‘vendor Hame: Dislogic Corporation
Stack Mame: <IP
Wersion 4.5.026
Libtary Path: brktip dil

General Information Tab The General Information tab contains information about the library
for SIP Stack

path, stack name, vendor name, and version number.

-l.! Brooktrout Configuration Tool - Advanced Mode
File View Options Help

=[]
I L A | & | 7
Haome Back I ewt Save  Apply | License Help
- Brecktrout (Boston Hest Service - Running]  |* General Infomation | 1P Parameters | T.38 Parameters | ATF Parameters
- Driver Parameters (41l boards)
BT Call Parameters ) bards] Library Path brktsip.dil
[=1- Call Cantrol Parameters Stack Mame: SIp
- Module 0x41: SR140
= 1P Call Control Modules Wendor Name:

Dialogic Corporation
Wersion: 4.5.0.26
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General Information Tab
for H.323 Stack

IP Parameters Tab for
SIP Stack

When you select an H.323 stack to configure, the General Information
tab displays, as shown in the following example:
-loix|

File Yiew Options Help

o
Home Save  Apply

& =
Back  Mest

4r

%

Help

Licenss

=+ Brookliout [Boston Host Service - Running) | General Information | |P Parameters | T.38 Parameters | RTP Parameters
i+ Driver Parameters [2l boards]
L. BTCall Parameters [All boards) Library Path: brkth323.dll
(=1 Call Control Parameters Stack Mame 37
i Module 0d1: SR140
=) IP Call Contral Modules Wendor Name: Dialagic Corporation

Wersion: 42232

The SIP IP Parameters tab allows you to set values for the following
parameters. Most of these parameters do not need to be set; the
defaults will work, but in practice, just like you configure the ID of a
fax machine, you should set From value and Phone Number.
However, if you have multiple NIC cards in your system, and you do
not want to use the first NIC card for the SIP traffic, you need to
specify the static (fixed) IP address of the NIC card you want to use
for the SIP messages in the Contact name field. This IP address will
typically be the same as the IP address selected under “Media IP
Interface” in the Parameters tab under the SR140 module, which
selects the NIC card for the FOIP traffic. If the local network has a
SIP proxy server and a SIP registration server, please contact your
network administrator to set the Primary Proxy Server and Primary
Registrar Server. If you do not have a SIP proxy/registration server,
you have to set Primary Gateway when your application is not
setting this value already.
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Contact Name

Set this parameter to the IP address of the network interface
(NIC) in the machine that you want to use for the SIP messages.
Here, you typically want to set the same IP address as the one
selected under the Media IP Interface parameter in the

IP Parameters tab under the SR140 module. When left blank, it
defaults to the first network interface in the system.

When this parameter is set to its default value
(sip_Contact=0.0.0.0), the SIP stack automatically attempts
to find the IP address of the local host during initialization. If the
host has not registered its host name, the SIP initialization
process will fail and SIP calls will not be processed. To process
SIP calls in this case, the value in the sip_Contact parameter
must be specifically set to an IP address of one of the host network
interface boards.

When set, this parameter must contain an IP address in the form:
XXX - XXX . XXX . XXX 2 PortNumber (port number is optional)
10.128.22.6:5060 (port number specified)
10.128.22.6 (no port number specified)
Note: For the SIP protocol, the port defaults to 5060 if not
specified.
Range: 0 — 255 for each dotted decimal position of the
IP address.
1 - 65535 for the port number
Value Type: dotted decimal

Default: 0.0.0.0:0 (system uses the IP address of the
local host and port 5060)

Primary Gateway

Indicates the IP address of a default gateway to use for outbound
calls. If you only specify a phone number when making a SIP call
and the application is not using a SIP proxy server, the Bfv API
forwards the call to the gateway specified with this parameter.
The Bfv API forwards the specified phone number to the gateway
for routing purposes.
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When set, this field must contain an IP address in the form:

XXX - XXX - XXX - XXX : PortNumber (Port number is optional)

10.128.22.6:5060 (port number specified)

10.128.22.6 (no port number specified)

Note: For the SIP protocol, the port defaults to 5060 if not
specified.

Range: 0 — 255 for each dotted decimal position of the

IP address.

1 - 65535 for the port number
Value Type: dotted decimal
Default: 0.0.0.0:0 (no default gateway defined)

The Bfv API does not use this parameter if the configuration file
specifies a sip_registration_server or sip_proxy_server.

Description URI

Indicates the value used for the u= line in the SIP SDP. The
u= line identifies the SIP uniform resource identifier (URI) of the
session description. Valid values are:

Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: <blank> (empty string)

Email Address

Indicates the value used for the e= line in the SIP SDP. The
e= line identifies the email address of the person or entity
responsible for the session. Valid values are:

Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: <blank> (empty string)

From Value

Indicates the value provided in the SIP header for the From field.
The From field contains a display hame and a SIP uniform
resource identifier (URI) or SIPS (secure SIP) URI that identifies
the originator of the session request. So, set the SIP address of
the SR140 Fax Software here. Valid values are:

Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: Anonymous

<sip:no_from_info@anonymous. invalid>"
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Maximum SIP sessions

Indicates the maximum number of concurrent session initiation
protocol (SIP) call control sessions. Note: setting this to a value
higher than the number of channels licensed for the SR140
virtual module will not increase the number of simultaneous
faxes that the SR140 can send/receive. Valid values are:

Range: 1 through 1000
Value Type: decimal
Default: 256

Phone Number

Indicates the value used for the p= line in the SIP SDP. The p=
line identifies the phone number to associate with the session.
Phone numbers use the conventional international format: the
number preceded by a + (plus symbol), the country code and a
space or hyphen character. For example:

+1 408-370-0881 So, please set this to the externally published
phone number for the SR140 virtual fax module. Valid values are:

Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: <blank> (empty string)

Primary Proxy Server
Additional Proxy Server #2
Additional Proxy Server #3
Additional Proxy Server #4
Indicates the address of the specified SIP proxy server. Define a

maximum of 4 proxy servers. Valid values are:

Domain name Indicates the name or IP address of the proxy

server.

Range: 1 - 4 proxy servers specifying any valid domain
name (for example, www._my_sip_server.com or
192.168.1.45)

Value Type: character string (up to 256 characters)

Default: <blank> (empty string indicating no proxy server
defined)
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Primary Registrar Server

Additional Registrar Server #3
Additional Registrar Server #4
Additional Registrar Server #4

Indicates the address of the specified SIP registration server. The

user can define a maximum of 4 registration servers. Valid values

are:

Domain name Indicates the name or IP address of the
registration server (up to 256 characters).

Range: 1 - 4 registration servers specifying any valid
domain name (for example,
www.my_registration_server.com or
192.168.1.45)

Value Type: character string (up to 256 characters)
Default: <blank> (empty string indicating no registration
server defined)

Session Description

Indicates the value used for the i=line in the SIP SDP. The i=line
provides a textual string that describes the session's purpose or
provides information about the session. Valid values are:

Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: <blank> (empty string)

Session Name

Indicates the value used for the s= line in the SIP SDP. The s=
line provides a textual string that gives a name to the session.
Valid values are:

Range: 1 - 255 characters
Value Type: character string (up to 256 characters)
Default: no_session_name

December 2010 116



Running the Dialogic® Brooktrout® Configuration Tool

Username

Indicates the name inserted into the o= line in the SIP session
description protocol (SDP). The o= line defines the owner or
creator of the session and the session identifier. This value must
not contain spaces. Valid values are: - (dash) = A dash or hyphen
character indicates the absence of an owner name or session ID.

Range:

1 - 255 characters

Value Type: character string (up to 256 characters)

Default:

- (dash or hyphen character)

£¥ Brooktrout Configuration Tool - Advanced Mode

File Wiew Options Help

=101x|

w | & = i &2 ?
Home | Back Hew | Save Appb | License | Help

- Brooktout [Boston Host Service - Running]
- Driver Parameters (4l boards)
- BTCall Parameters (4l boards)
= Call Control Parameters
- Madule 0x41: SH140
= IP Call Cantral Modules
P

General Information  IP Parameters | 7,38 Parameters | RTF Parameters |

Maximum SIP sessions:

Primary Gateway: [i] [i] a

1)

[ 1| —p)——— 1m

—

Primary Prosy Server:

Additional Proky Server #2:

Additional Proxy Server #3:

Additional Proky Server 4.

Additional Registrar Server #2:

Additional Registrar Server #3

Additional Registrar Server #4:

I
I
I
I
Primary R egistrar Server: |
I
I
I
|

From walue; [anorEmos <sip:na_from_infa@anonymos. invalid>
Cartact name: a 0 a 0 ID

Usemame: |-

Session name: [no_session_nams

Session desciiption: [

Description LIR: [
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IP Parameters Tab for When you select an H.323 stack to configure, the IP Parameters tab

H.323 Stack allows you to set values for the following parameters (see example on
page 123). Most of these parameters only need to be configured when
you have a gatekeeper in your local network. However, if you have
multiple NIC cards in your system, and you don't want to use the
first NIC card for the H.323 traffic, you need to set the static (fixed)
IP address of the NIC card you want to use for the H.323 messages
in the h323_local_ip_address field. This IP address will typically be
the same as the IP address selected under Media IP Interface in the
IP Parameters tab under the SR140 module, which selects the NIC
card for the FOIP traffic. If not set, it will take the IP address of the
first Ethernet interface (NIC card) in the chassis. If you don't have
an H.323 gatekeeper, you have to set h323_default_gateway when
your application isn't setting this already.

Primary Gateway

Indicates the IP address of a default gateway to use for outbound
calls. If you only specify a phone number when making an H.323
call and the application is not using an H.323 gatekeeper, the Bfv
API forwards the call to the gateway specified with this
parameter. The Bfv API forwards the specified phone number to
the gateway for routing purposes. When set, this field must
contain an IP address in the form: xxx.xxx.xxx.xxx:PortNumber
(Port number is optional)
Examples
10.128.22.6:1720 (port number specified)
10.128.22.6 (no port number specified
Note: For the H.323 protocol, the port defaults to 1720 if not
specified.

Range: 0 — 255 for each dotted decimal position of the

IP address.

1 - 65535 for the port number
Value Type: dotted decimal
Default: 0.0.0.0:0
Note: The Bfv API does not use this parameter if the

configuration file specifies a value of 1 for the h323_register
parameter.

December 2010 118



Running the Dialogic® Brooktrout® Configuration Tool

E.164 Aliases

Specifies the E.164 alias of the H.323 terminal. This alias is used
during gatekeeper registration and call establishment. It
identifies the phone number of the H.323 terminal.

You can specify multiple aliases, each starting on a new line
using the same parameter name. For example:
h323_el64alias 123456

h323_el64alias 4084839648

h323_el64alias 5102987468

h323 el64alias 9627842899

When you specify multiple values, the system registers every
value with the gatekeeper.

Valid values are:
Range: 1 - 128 characters (inclusive)

Value Type: character string restricted to numbers 0 through
9 and the star (*) and pound (#) symbols

Default: <blank>

Gatekeeper ID

Specifies the ID of the H.323 gatekeeper that the H.323 terminal
will attempt to find during the gatekeeper discovery routine. If
you do not set this parameter, the H.323 terminal will attempt to
register with the first gatekeeper it finds. Valid values are:

<blank> = Uses the first gatekeeper the H.323 terminal locates.
Value Type: Unicode character string (up to 256 characters)
Default: <blank>
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Primary Gatekeeper

Fallback Gatekeeper #2
Fallback Gatekeeper #3
Fallback Gatekeeper #4
Fallback Gatekeeper #5
Fallback Gatekeeper #6

Specifies the IP address of up to six H.323 gatekeepers that will
receive the registration request from the H.323 terminal. If you
leave this parameter blank, the H.323 terminal will perform a
multicast gatekeeper discovery routine to find the gatekeeper
using port number 1719. Valid values are:

XXX o XXX o XXX . XXX

0.0.0.0:0

Range:

Value Type:
Default:

Gatekeeper Time to Live

Configures the system to use the specified
H.323 gatekeeper. Set the gatekeeper IP
address in the form:

XXX . XXX . XXX . XXX - PortNumber

Configures the system to use a multicast
process to discover the H.323 gatekeeper
using port number 1719.

0 — 255 for each dotted decimal position of
the IP address.

1 — 65535 for the port number
dotted decimal

0.0.0.0:0 (uses multicast discovery
process and port number 1719)

Specifies the number of seconds to allow between registration
request messages sent from the H.323 terminal to the
gatekeeper. After reaching this limit, the H.323 terminal
generates another registration request to the gatekeeper because
the previous request is now considered invalid. Valid values are:

Unit: second

Range: 0 - 32,000,000 (0 means that gatekeeper
registrations do not expire; 32,000,000 seconds
equals one calendar year)

Value Type: integer

Default: 0
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Local H.323 Terminal ID

Specifies the H.323 ID of the H.323 terminal. This alias is used
during gatekeeper registration and call establishment. It
identifies the name of the H.323 terminal. You can specify
multiple aliases, each starting on a new line using the same
parameter name. For example:

h323_h323IDalias andrew

h323_h323IDalias bob

h323 _h323I1Dalias charles

h323_h323IDalias david

When you specify multiple values, the system registers every
value with the gatekeeper. Valid values are:

Range: Up to 256 characters
Value Type: Unicode character string
Default: <blank>

Local IP Address

Specifies the transport address of the H.323 terminal. The
transport address can be an IP address or a combination of the IP
address and the port number that the H.323 call control stack
uses. If you do not provide an address, the system uses the IP
address of the first Ethernet interface (NIC) in the system and
port number 1720. Here, you typically want to set the same IP
address as the one selected under the Media IP Interface
parameter in the IP Parameters tab under the SR140 module.
Valid values are:

XXX o XXX 2 XXX - XXX Configures the system to use the specified
IP address for H.323 calls. Set the
transport address in the form:

XXX XXX XXX XXX:PortNumber

0.0.0.0:0 Configures the system to use the address
of the first Ethernet module and port
number 1720.

Range: 0 - 255 for each dotted decimal position of
the IP address.

1 — 65535 for the port number
Value Type: dotted decimal

Default: 0.0.0.0:0 (uses first Ethernet module
and port number 1720)
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Name of Manufacturer

Specifies a string naming the H.323 terminal’s manufacturer.

Range: Up to 256 characters
Value Type: Unicode character string
Default: "Dialogic Corporation™

Manufacturer Code

Specifies a code that identifies the manufacturer of the H.323
terminal making the call.

Range: 0-255
Value Type: decimal
Default: 48

Note: 48 is the H.323 manufacturer code for Dialogic
Corporation.

Maximum H323 Sessions

Indicates the maximum number of concurrent H.323 calls that
the host module can support at one time. Set this value to a
number that at least doubles the number of channels in the
system because the system can be tearing down a call while
processing the next call. Setting this to a higher value will not
increase the number of simultaneous fax calls that have been
licensed. Valid values are:

Range: 1 through 65535 (inclusive)
Value Type: decimal
Default: 256

Register with Gatekeeper
Specifies an integer value that determines whether to register
with an H.323 gatekeeper. Valid values are:
0 = Does not register with an H.323 gatekeeper.
1 = Registers with an H.323 gatekeeper.
Value type: integer
Default: 0
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Support Alternate Gatekeepers

Specifies whether to support alternate gatekeepers. The
gatekeeper receiving the registration request from the H.323
terminal must also support alternate gatekeepers.

When the H.323 terminal sends a registration request to its
primary gatekeeper, the primary gatekeeper will send the H.323
terminal a list of alternate gatekeepers that it knows about. If, for
some reason, the H.323 terminal can no longer communicate with
its primary gatekeeper, it will go through the list of alternate
gatekeepers and attempt to register with them.

When alternate gatekeepers are not supported and the H.323
terminal can no longer communicate with its primary
gatekeeper, it will go through the multicast gatekeeper discovery
routine to find an available gatekeeper. Valid values are:

0 = Does not support alternate gatekeepers.

1 Supports alternate gatekeepers when necessary.

Value type: integer
Default: 0

T.35 Country Code

Specifies a code identifying the international country that
manufactured the H.323 terminal making the call. The code
allows other H.323 terminals to know the origin of the H.323
terminal. The ITU-T Recommendation T35 Annex A lists the
country codes used for H.323 Non-Standard Facilities (NSF).
Range: 0 - 255

Value type: decimal

Default: 181
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T.35 Country Code Modifier

This parameter specifies a modifier for the country code of the
vendor’s H.323 terminal making the call. If the T.35 country code
is defined as hexadecimal FF, this extension value defines a two-
byte manufacturer country code.

0 Does not support alternate gatekeepers.

1 Supports alternate gatekeepers when necessary.

Value type: integer

Default: 0
£y Brooktrout Configuration Tool - Advanced Mode =] 5]
File Visw Options Hslp
i} s = %] &1 ?
Home Back  Hext Save  Apply | License Help
=)-Brookirout (Bastan Host Service - Running] | General Information | IF Parameters | 7.32 Parameters | ATP Parameters |
- Diiver Parameters (&l boards]
- BTCall Paramsters (Al boards) Local IP Address: [0 o0 o 0o =
- Call Control Parameters
 Module Dxd1: SA140 Maximum H323 Sessions: [25¢
=1 IP Call Cantral Modules e 6 .
iy Gateway: I 0.0 0. 0 o
H.323
Register with a Gatekesper: IT o J— 1
Gatekeeper ID: [
Primary Gatekeeper. I 0.0 0. 0 o
Gatekeeper Time To Live: o
Support Alternate Gatekespers: Jo o p——1
£ 164 Alases | =l
Local H.323 terminal ID I =]
Fallback Gatekeeper H2: I 1} 1} 1} o 0
Fallback Gatekesper #3: I 0.0 0.0 o
Fallback Gatekeeper H#4: 1} 1} 1} o 0
Fallback Gatekespsr H5: [0 .0 . 0.0 o |
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T.38 Parameters Tab for

The T.38 Parameters tab for a SIP stack allows you to set values for
SIP Stack

the following parameters. These parameters should work without
being modified.

-# Brooktrout Configuration Tool - Advanced Mode

=10l x|
File View Optons Help
il L H @ &3 T
Home | Back  Mew | Save  Apply | License | Hep
=)- Brookurout [Boston Host Service - Stopped)

General Information | IP Parameters  1.38 Parameters | RTP Parameters |
- Driver Parsmeters [l biosrds)

-~ BTCall Parameters [All boards)

R o 2 el [T-3 any =l
1 Call Control Parameters
Module 0xd1: SFR140 EEIEEIE R e e [
Er ”? F::‘PED”"D' Biochies Masimum it Rate, bps: [14400 |
Media Renegotiate Delay Inbound, msec: [1o00
Media Renegatiate Delay Outhound, msec: [
T30 Fast Notify: [Mo =l
UDPTL Redundancy Depth Cantrol [5 0 J s
UDPTL Redundancy Depth Image: [z 0 J 2

Show Advanced >

T.38 Parameters for H.323 The T.38 Parameters tab for an H.323 stack allows you to set values

Stack for the following parameters. These parameters should work without
being modified.

4% Brooktrout Configuration Tool - Advanced Mode
File View Options Help

i & = = & T
Home | Back Mewt | Save Appl | License | Help
=1~ Bracktrout [Baston Host Servics - Stapped]

General Information | IF Parameters  T.38 Parameters | RTF Parameters |
Diiver Parameters (41l boards)

BTCall Parameters (&l boards)

Faz, Transporting Protocal: = =l
=1 Call Control Parameters
Module Dx41: SR140 Generate CED tone over RTP: fiie |
=) IFT.'.:S‘IECZD;"OIMOCMES Masimum Bit Rate, bps: [14400 =1
Media Renegotiate Delay Inbound, msec: [1000
Media Renegotiate Delay Outbound, msec: 5]
T30 Fast Notify I =1
UDPTL Redundancy Depth Cantral [5 0 ) &
UDPTL Redundancy Depth Image: [z 09— 2

Show Advanced »>
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RTP Parameters for SIP
Stack

File View Options

=1k
Help
¥ L = 87 ?
Home | Back Mest | Save  Apply | License | Help
51+ Brooktrout [Bosten Host Service - Stopped] | || General Infarmation | I Parameters | T.38 Parameters  RTP Paiameters |
- Diiver Parameters (A1l boards)
BTCall Parameters &l boards) RTP codec list: [ocmu pema
=)- Call Control Parameters
Module Dx41: SR140 Silence Control [inband k3|
=1+ IP Call Control Modules
SIP Show Advanced >

RTP Parameters for H.323
Stack

#¥ Brooktrout Configuration Tool - Advanced Mode o [

File Wiew Options Help

fal & =» =] 2 &2 T

Home | Back flewt | Save apply | License | Help

- Brooktrout (Easton Host Service - Stopped) | General Information | 1P Parameters | T.38 Parametsrs RTP Parametars |

Diiver Parameters (A1l boards)
BTCall Parameters (Al boards) RTP codec list
) Call Control Parameters

IDCWU PCma
i Module Dx41: SR140 Silence Control:
[=- IP Call Contral Modules

[inband

Show Advanced »> I
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Advanced Settings

Show Advanced Button When a parameter panel (for example: Driver Parameters, BTCall
Parameters, Call Control Parameters) has advanced settings, the
Show Advanced >> button appears on the bottom right of the right

panel.
% Brookbrout Configuration Tool - Advanced Mode (O[]
File ‘“iew DOptions Help
@« = ® S| ¥
Home Back et Sawve  Apply | License Help
- Brooklrout [Boston Host Servic - Rurning] | |~ BTCal Parameter
Driver Parameters (Al boards]
- BTCall Parameters (A1l boards) Country Telephony Parameter Fils: IBT_CPAF\M.CFG E”‘I
[=- Call Control Parameters
.- Module 0341 SR140 Country [usaonio =
= ‘F:l Eg:\PEontlo\ Modles M awimum Timeout, sec: IT 0 )—— 99
Debug
APl Debugging: Disabled -
st Db Lo e e [EABrecktaut Bostortusiwinntibintear (21 3|
Znd B ebug Log Bl Hams I l_"l ﬁl
bl i D et File iz I1UUUUUUU
Tirace BiiAF Functiar Eall: [Disatle =
Show Advanced »»
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Hide Advanced Button

panel appears, and the Hide Advanced << button is displayed.

There can be more than one panel of parameter information for

Advanced Settings.

When you click Show Advanced, the Advanced Settings portion of the

Click the Hide Advanced << button to remove advanced parameters
from the screen view.

Note: Most users never need to alter the Advanced Settings

parameter values. If you know these settings are incorrect,
please contact Dialogic Technical Services and Support for
more information. See Getting Technical Support on page 12.

#¥ Brooktrout Configuration Tool - Advanced Mode

IS[=] 3
File ‘“fiew Optionz Help
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Home: Back  [leqt Save  Apply | License | Help
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Returning to the Default Configuration

» To return to the default configuration, follow the
instructions below:

1. While in the Advanced Mode, click on Options->Preferences and
notice where the BTCall Configuration File and the Call Control
Configuration File are located.

Exit from the Configuration Tool.

Delete either the BTCall Configuration File or the Call Control
Configuration File or both based on what you would like to reset.

4. Next start the Configuration Tool again.
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5 - Testing Dialogice Brooktroute SR140
Software and TR1034/Trufax Boards

v

This chapter explains how to use Dialogic® Brooktrout® Fax/Voice
Diagnostic Test Tool for Windows® SDK version 6.3 to test the
following:

m  Dialogic® Brooktrout® SR140 Fax Software

m  Dialogic Brooktrout® TR1034 Series and Dialogic Brooktrout®
TruFax® boards

You must have installed the SR140 license file and therefore your SR140
virtual module, before you continue here with configuration and testing.
See Chapter, Activating Dialogic® Brooktrout® SR140 Fax Software on
page 27.

If you ISV’s application does not contain the Diagnostic Test Tool,
you can download a copy from the Dialogic Technical Services and
Support website. See Getting Technical Support on page 12 and
download the FDTool test tool that supports Boston driver version
6.3.

Also at the website you will find White Papers and Frequently Asked
Questions besides Downloads. Dialogic recommends that you look on
this site under the SR140 product and FOIP/T.38.

If you have already installed your LAN Fax application, you might want to
first use the LAN Fax application to test your boards. If your application
functions properly, then you do not need to use this test tool.
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You can test a maximum of 8 channels simultaneously on the
FDTool Diagnostic Tool in a Windows® operating system. See
System Requirements on page 128. The System Requirements
should be the same as in the SDK 6.3 Release Notes.

This chapter covers the following major topics:

System Requirements
Installing the Diagnostic Test Tool
Menus and Submenus

Generating Logs for Troubleshooting
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System Requirements

System Requirements

The Fax/Voice Diagnostic Test Tool provides all the necessary
software to send/receive a Fax over IP using the SR 140 virtual
module.

You must have the following system requirements in order to use
this tool to test your SR140 fax software and TR1034/Trufax boards:

Windows® 2000 Professional, Service Pack 4 and Windows®
Update 822831

Windows® 2000 Server, Service Pack 4 and Windows® Update
822831

Windows® 2000 Advanced Server, Service Pack 4
Windows® XP Professional, Service Pack 2
Windows Server® 2003, Standard Edition, Service Pack 2

Windows Server® 2003 x64 Editions, Service Pack 2
x86-64, Intel 64-Bit Xeon; Intel Pentium with EM64T

Windows Server® 2003, Enterprise Edition, 32-bit version,
Service Pack 2

Windows Server® 2008

Windows® 2000 with Service Pack 4 requires Windows® Update
822831 due to a Windows® issue with Service pack 4 that would cause
the PnP driver to fail.
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Installing the Diagnostic Test Tool

Installing the Diagnostic Test Tool

This section describes how to install and configure the diagnostic
test tool and generate log files.

Note: You might have received the Brooktrout Hardware Test files as
part of your fax application. If not, download a self-extracting zip file
from the web by doing the following:

5. Go to the following Dialogic website
http://www.dialogic.com/support/helpweb/brooktrout/).

6. Under Diagnostic and Testing Utilities selected Using the
Dialogic Brooktrout Fax and Voice Diagnostic Tool for Windows.

Below FDtool for Drivers v6.3 - SDK 6.3, select Download.
Save the zip file to an empty directory and unzip it.
9. Extract the files to the current directory.

& C:\fdtool-60¥dtool-6.0.0

File Edit View Favorites Tools Help

@Back - &9 ? / ) search || " Folders v

Address | C:ifdtool-601fdtook-6.0.0

., — ]. Name Size  Type
File and Folder Tasks 3 B Dbin File Folder
) Make a new folder j;o_nflg Ei{e ::o::er
river le Folder
] t\f:Eh i foketiionhe logs File Folder
&? Share this folder Omedia File Folder
2 FDtool exe 20KE  Application

10. To launch the Diagnostic Test Tool, double-click the FDTool.exe
icon. The following screen appears.
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Installing the Diagnostic Test Tool

€] rdtool : driver v6.0.0 Build 7
File Tools Help

[ Configure ” Initialize ”SRNB [41] ¥l| Dia Reset || Dial All

Channel Status Dialstring

Port History
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Menus and Submenus

Menus and Submenus

The following table lists the menus and submenus of the Diagnostic
Test Tool.

Table 3. Diagnostic Test Tool Menus and Submenus

Menus Submenus

File ¢ Configure
¢ Initialize
Exit

*

Tool Debug

VTTY Tracer

Reset Alarm Counters
Reset Configuration
Send Multiple TIFF
Reject Incoming Calls

® & ¢ ¢ o o

*

Help Help

+ About fdtool
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Menus and Submenus

11. From the fdtool-60\fdtool-6.0.0 screen click the Configure button.
The following screen appears

Brooktrout Configuration Tool - Preferences E]
BTCall Configuration File: |C:\fdtool 60%dtook 6.0.0hconfi @[
Call Control Configuration File: [C:\dhool 60\dtook6.0.0hcont @"j
INF File: |__\d:ivers\pnp\lrxslream.in[ g
Firmware File Location: [C:\fdtool 60\fdtool6.0.0%in §i
Log File Location: [C:Afdhool 60\dtook6.0.0Nogshconfi
Boston Host Service Start Mode: | anyal ~|

oK |

12. Refer to the Running the Dialogic® Brooktrout® Configuration
Tool on page 95 for instructions for using the Configuration Tool.

13. Click OK and the following screen appears.

[€] rdtool : driver v6.0.0 Build 7 =]
File Tools Help

(Corpre )[iies ] [55290 to2 v

Channel Status Dialstring
1

| Port History
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Menus and Submenus

14. Click Initialize. The following screen appears.

€] fdtool : driver v6.0.0 Build 7

The selected module (0x41) has 120 channels, Note
that FDtool can only support 8 SR140 channels.

DO UOUTOU oTOrTaTTT

07 - 000/000  Waiting for call...

Eile Tools Help
[ Configure || Initialize ]|5R14" [41] V| [ Reset || ial &l ||Reset al|
’ hannel Status Dialstring ‘
|
A Info
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Menus and Submenus

15. If there are more than eight SR140 channels, the information
bubble above appears. If not, the following screen appears.

[€] fdtool : driver v6.0.0 Build 7

Fle Tools Help

| configure || Initialize | sR140 [41] ¥ Dol | Reset || Dislal || Reset al|
Channel Status Dialstring

T e ——

l32 UBU{EIJB Wai:tng For caﬂ..

03 - 000/000  Waiting For call...
04 - 000/000  Waiting For call...
05 - 000/000  Waiting For call...
06 - 000/000  Waiting For call...
07 - 000/000  Waiting For call...
08 - 000/000  Waiting For call...

| PortHistory | Channel 1

15:21:28.559
i Waiting For call...
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Menus and Submenus

16. The following screen indicates that you have entered a dial string.

] fdtool : driver v6.0.0 Build 7

Bie Tools Help
[ Configwre |[ nitislze ] |SR140 [41] ¥ || Dial || Reset || Dialall |[Reset Al
[ Chamel Status I

02 OUD,-’CIJD Watlng For ca!..
03 - 000/000  ‘Waiting for call...
04 - 000f000  Waiting For call...
0S - 000/000  Waiting For call..,
06 - 000f000  Waiting For call...
07 - 000/000  ‘Waiting for call...
08 - 000f000  Waiting For call...

Port History Channel 1

00 162 Wai:lngforcal

17. Click Dial to start the outgoing fax.

& fdtool : driver v6.0.0 Build 7 (=14

ble Tools Help

[ configure |[ Intishize || SR140 [41] ¥ 0l [ Reset || Dial all |[Reset an |
Channel . Status Dialstring . .

| 01-000j000 | Waitingforcal,, [ |

02 - 000/000  ‘Waiting for call...
03 - 000f000  Waiting for call...
04 - 000f000  Waiting For call...
0S - 000/000  Waiting For call...
06 - 000/000  ‘Waiting For call...
07 - 000f000  Waiting for call...

08 - 000f000  Waiting For call...

Channel 1

Read
Waiting for call...

e
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Menus and Submenus

18. The following screen indicates that the fax is being sent from
channel 1 to 2.

€] tdtool : driver v6.0.0 Build 7

Eile Tools Help

[ configurs | Intidize ||SR140 [41] v| o [Reset |[oisl il |[Reset all]
[ Channel Status Dialstring

Remote ID is "fdtool" 123@10.128.16.135

02 - 000f0D0  Stark Receiving fax...
03 -000f000  ‘Waiting for call,..
04 - 000fO00  Waiting For call...
05 -000f000  ‘Waiting For call...
06 - 000f000  Waiting For call...
07 - 000f000  Waiting For call...
08 - 000f000  ‘Waiting For call..

Port History Channel 1
15:27:59.942 Ready.
15:28:00.162  ‘Waiting for call...
15:28:56.213 Dialing "123@10.126.16.135",..
15:28:57.435 Connected
15:28:57.495 Sending “send.tiff"...
15:28:57.505 Local ID is "fdtool”

H Start Sending fax...
Getting Remote ID...
Remote ID is "fdtool”
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Menus and Submenus

19. The following screen displays the history information for channel

1.

] fdtool : driver v6.0.0 Build 7
Eile Tools Help

| channel Status Dialstring
Waiting for send complete. .. 123@10.128.16.135
02 - 000/000  Receiving page...
03 -000/000 ‘Waiting For call..,
04 - 000/000  Waiting for call...
05 - 000f000  Waiting for call...
06 - 000f000  Waiting for call...
07 - 000/000  ‘Waiting For call..,

[ configure [ mnitialize || SR140 [41) | o

Part History Channel 1

15:28:57.435 Connected

15:28:57.495 Sending “send.tiff"..,

15:28:57.505 Local ID is "fdtool”

15:28:57.515 Start Sending Fax...

15:28:57.525 Getting Remote 1D...

15:28:59,398 Remote ID is "fdtool"

15:29:04.325 Fax Training Details

15:29:04,325 => Signalling Rate = 14400 (¥.17)
15:29:04.325 => Resolution = 200Hx200¥ {Fine)
Sending page 1...

15:29:04.375 | Waiting For send com

£
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Menus and Submenus

20. Click on the line for channel 2 to display the information for that
channel.

@ fdtool : driver v6.0.0 Build 7

File Tools Help

[ Configure |[ Intislize | SR140 [41] ~| ol [Reset |[ Dial al |[Reset at
Channel Status Dialstring

01 - 001 /000 watlngfcrcal 123@10,128.16.135

02 -00i/000 | Watingforeall.,. ... | -~ |

03 - 000/000 Watlng for cal. o

04 - 000/000  VWaiting For call...
0S - 000/000  ‘Waiting For call...
06 - 000/000  WWaiting For call. ..
07 - 000000 Waiting for call...
08 - 000/000  ‘Waiting For call..

Port History Channel 2 -

15:29:09.933 =3 TotalLines = 2224
15:29:09.933  => Confirm Yal =MCF
15:29:09.943 Waiting for receive complete. ..
15:29:12,196 ——— Summary --------—
15:29:12.196 TotalPages =1
15:29:12.196  Duration = 16 seconds
15:29:12,196 ECM = enable, with 256 byte frames
15:29:12.196 Line Format =MMR
15 29:12,196 Receive complete
| Terminating call
Waiting for call...

21. To enable logging, click Debug from the Tools menu.
22. Click Help About and the following screen appears:

About fdtool... 3}

| Boston Bfy API v6.0.0 Build 11 (compiled with v6.0.0 Buld 11) A |
Boston Driver v6.0.0 Build 7
Boston SDK v6.0.0 Build 11 {compiled with +6.0.0 Build 11)

Module Ox41

Boot Rom : 6.0.0B84 Oct 27 2008 : VIRTUAL FAX BOARD PROD...
Ctrl Proc : Not Available

Feature Set :
=2 FtrLockM = true
=>VoiceCh =0
=>FaxCh =120
=>Llinks =0
=>V34Enab = 0 7
- Pl M. a e

FaxDiag Tool - :
TR1000/TR1034/SR140/TruFax DIa]@g1C-
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Generating Logs for Troubleshooting

Generating Logs for Troubleshooting

Logging

Debug Submenu

v

Various log files can be created for troubleshooting. All logs are
created in the directory where the test tool is extracted.

Note: When Dialogic Technical Services and Support requests that
you send log files to them, make sure you zip the log files prior
to sending them.

The Logging menu provides the following logging/saving functions:

m  Debug
m VTTY Tracer

The most useful logging information for Dialogic Technical Services
and Support generally is the Brooktrout debugging logs. The various
possibilities for these files are as follows:

m  apidebug_unit_xx.log
m apidbug_systemlog

These logs are written to continuously when you select the Brooktrout
Debug Logging submenu.

The Debug logging feature should be turned on only under the
direction of Dialogic Technical Services and Support.

VTTY Tracer Submenu » You can select the VTTY Tracer from the Tools menu.
1. Follow the instructions on the screen below.
i ) Do the following when the ¥TTY ISDN Tracer tool is displayed:
* Choose Settings ... Options and click "Trace Output to Screen” AND "Trace output to File", specifying a path to a
log file to be created as the tool runs.
* Choose File ... "Connect to Module” and specify the same module number as the one you specified for "Download
firmweare” in the main screen.
* Choose Trace ... "Layer 2 (normal)” to enable tracing.
* Close tool when finished!
Choose File ... Disconnect to disconnect from the module/board.
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Generating Logs for Troubleshooting

2. Click OK and the VTTY Tracer utility appears. The select the
setting indicated on the screen above.

Disconnected - VTTY Tracer E
FEile Edit View Settings Memory Show TIrace Help

*a = &

Ready

Other Tools Options There are three other options under the Tools menu:

m  Reset Configuration - clears out the configuration files created
with the Configuration tool. The Configuration tool would need
to be run again by clicking on the Configuration button before
the FDTool can be used again. It resets the whole configuration.

m  Send Multipage TIFF - Usually only a single-page TIFF file is
used for sending faces with the FDTool. Selecting this option
sends out a three pages TIFF file that alternates the fax
resolution from fine to normal - bank to fine.

m  Reject Incoming Calls - If this is selected, incoming calls will not
be answered. The utility would only be able to place outbound
calls.
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6 - Dialogice Brooktrout® SR140
Software and TR1034/Trufax
Specifications

Specifications

Fax

ITU T.30; ITU T.38; IETF RTP; Group 3
V.17, V.29, V.27ter, V.21, V.34 modulation
Up to 33.6 Kbps with auto fallback

Normal and fine resolution: 1200x1200
MH, MR, MMR compression

Transparent image conversion

A4, A3 and B4 page sizes with scaling

A4 and B4 TIFF F file widths

Enhanced ASCII conversion support with headers
Error Correction Mode (ECM)

Line error detection/repeat good line
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Specifications

RTP

m  G.711 20 and 30ms packets

\Voice

Prompt Playback

Prompt Record

Playback Gain Control

Inbound and Outbound Silence Suppression
Dynamic Range Control

High Frequency Preemphasis

Signal Generation/Detection

B G.711 Single Frequency Tone Generation
m  G.711 DTMF Tone Generation

m  G.711 DTMF Tone Detection

m  Adaptive Call Progress Analysis
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Specifications

Call Control
m H.323
m SIP

Operating Systems

Windows® 7, 32-bit version

Windows® 7, 64-bit version

Windows Server® 2008 R2, Enterprise Edition, 64-bit version
Windows Server® 2008, Enterprise Edition, 32-bit version
Windows Server® 2008, Enterprise Edition, 64-bit version

Windows Server® 2003, Standard Edition, 32-bit version,
Service Pack 2

B Windows Server® 2003, Standard Edition, 64-bit version,
Service Pack 2

m  Windows Server® 2003, Enterprise Edition, 32-bit version,
Service Pack 2

m  Windows Server® 2003, Enterprise Edition, 64-bit version,
Service Pack 2

Windows® XP Professional, Service Pack 3
Windows® 2000 Advanced Server, Service Pack 4
Windows® 2000 Server, Service Pack 4
Windows® 2000 Professional, Service Pack 4

Installation and Configuration

®  Windows® Graphical Configuration Tool

Application Programming Interface

m  Dialogic® Brooktrout® Fax and Voice (BFV)
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Supported and Tested Devices for Interoperability

For the latest listing of Dialogic® Brooktrout® FolP interoperability
information refer to the following site:

http://www.dialogic.com/interoperability/fax.htm

This list includes the following hardware devices (and their
respective software revisions) that have been tested for
interoperability with the SR140 Fax Software:

m [P PBX
m  Gateways
m  Other devices
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Symbols

.cfg file 97, 104

.exe file 92, 100, 107
lic file 53

Jxt file 42

A

Activation Methods 34
Advanced Mode
Advanced Settings information 128
Configuration Tool 90
menu options 91
See also Configuration Tool
Advanced Settings, Advanced Mode 128
Automatic activation 36

B

Backing up licenses 53
Bfv API debugging 102
bkrtlicmgr.exe file 92, 100, 107
Boston Host Service
License Manager 107
brktlicmgr.exe file 30
Brooktrout License Activation Center
installing licenses 49
Brooktrout License Manager
activate 105
BTCall parameters 102
btcall.cfg file

choosing the location 97
configuration file 102

C

Call Control parameters
Report Panel Tab 104
callctrl.cfg file
configuration file 104
Configuration Tool
Advanced Mode 90
BTCall Parameters 102
debugging 102
Driver Parameters 93
file locations 97
help 97
IP call control parameters 111
parameter grouping 90
protocol options 86
running 95
Wizard Mode 64
Wizard Mode defaults 86
Copying license files 49
Creating text files 42, 48

D

Debugging
Bfv API 102

Driver
Configuration Tool parameters 93
reconfiguring 94, 100
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E

Email activation 47

F

Fax activation 47

G

Grouping parameters, Advanced Mode 90

H

Hardware information, Wizard Mode 66
Help

Brooktrout Configuration Tool 97
Hide Advanced button 128
Host Based Fax

Configuration Tool 105

SR140 module unavailable 108

IP Call Control
modules parameters 111
SIP parameters 112
T.38 parameters 125

L

License
adding 36, 48
authenticity 30
automatic activation 36
backup up files 53
copy files 49
email activation 47
fax activation 47
file access 49, 56, 62
removal 53

License Activation Wizard
activation methods 34
automatic activation 36
email activation 47
fax activation 47

web activation 41
License button 107
License files

backing up 53

location 49

naming 53
License Key

invalid 38
License Manager

executable file location 30

starting 30
License update

SR140 module 105

N

Naming license files 53
Node Lock 42

P

Parameter grouping
Configuration Tool 90
Product Registration
email addresses 37
email request 48
fax request 48
information 37
owner information 37
Protocol options, Wizard Mode 86

R

Reconfiguring the driver 94, 100
Removing licenses 53

S

Saving information 42, 48
Show Advanced button 127
SIP parameters, IP Call Control 112
Software information, Wizard Mode 66
SR140 module

licensing information 105

no license 108

Parameters tab 108
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T

T.38 parameters, IP Call Control 125
Text file location 42
Troubleshooting

license key invalid 38

multiple license problems 30

wW

Web activation
instructions 41
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